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Definizioni delle note
Nella presente Guida dell'utente vengono utilizzati i seguenti simboli e convenzioni:

 AVVERTENZA AVVERTENZA indica una situazione potenzialmente pericolosa che, se non
evitata, può causare la morte o lesioni gravi.

 ATTENZIONE ATTENZIONE indica una situazione potenzialmente pericolosa che, se non evitata,
può causare lesioni di entità lieve o moderata.

IMPORTANTE IMPORTANTE indica una situazione potenzialmente pericolosa che, se non
evitata, può causare danni alle cose o la perdita di funzionalità del prodotto.

NOTA NOTA specifica l’ambiente operativo, le condizioni di installazione o speciali
condizioni di utilizzo.

Le icone dei suggerimenti segnalano suggerimenti utili e informazioni aggiuntive.

Grassetto Lo stile grassetto identifica i pulsanti sul pannello di controllo della macchina o
nella schermata del computer.

Corsivo Lo stile corsivo evidenzia un punto importante o rimanda a un argomento correlato.

  Informazioni correlate

• Prima di utilizzare la macchina Brother 
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Precauzioni generali

Rotoli RD

• Usare accessori e materiali di consumo Brother (indicati dal simbolo ).

• Se l'etichetta viene applicata a una superficie bagnata, sporca o oleosa, potrebbe staccarsi facilmente. Prima
di applicare l'etichetta, pulire la superficie sulla quale essa verrà attaccata.

• Conservare il rotolo RD in luogo fresco e buio, utilizzarlo subito dopo aver aperto la confezione che lo
contiene.

• Non esporre il rotolo RD alla luce solare diretta, a temperature o umidità elevate, a vento o a polvere per
evitare che le etichette possano sbucciarsi o scolorire.

• Se si graffia con le dita od oggetti metallici la superficie stampata dell'etichetta, oppure se la si tocca con le
mani umide, il relativo colore potrebbe cambiare o sbiadirsi.

• NON applicare etichette su persone, animali o piante. Non applicare mai etichette in luoghi pubblici o privati,
senza l'apposita autorizzazione.

• Le ultime etichette rimaste nel rotolo RD potrebbero non essere stampate correttamente. Per questo motivo,
ciascun rotolo contiene più etichette del numero indicato sulla confezione.

• Quando un'etichetta viene rimossa dopo essere stata applicata a una superficie, è possibile che una parte di
essa resti attaccata.

• Dopo che un'etichetta è stata applicata, la sua rimozione potrebbe risultare difficoltosa.
• Avvertenze e precauzioni di sicurezza uu Guida di sicurezza prodotto

  Informazioni correlate

• Prima di utilizzare la macchina Brother 
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Marchi e licenze
• Android e Google Chrome sono marchi di Google LLC.
• QR Code è un marchio registrato di DENSO WAVE INCORPORATED.
• Epson ESC/P è un marchio registrato di Seiko Epson Corporation.
• Mac, Safari, iPad, iPhone e iPod touch sono marchi di Apple Inc.
• Mozilla e Firefox sono marchi registrati di Mozilla Foundation.
• QR Code Generating Program Copyright © 2008 DENSO WAVE INCORPORATED.
• BarStar Pro Encode Library (PDF417, Micro PDF417, DataMatrix, MaxiCode, AztecCode, GS1 Composite,

GS1 Databar, Code93, MSI/Plessey, POSTNET, Intelligent Mail Barcode)
Copyright © 2007 AINIX Corporation. Tutti i diritti riservati.

• Blue SDK
Copyright © 1995-2018 OpenSynergy GmbH.
Tutti i diritti riservati. Tutti i diritti non pubblicati riservati.

• Parti di questo software sono protette da copyright © 2014 The FreeType Project (www.freetype.org). Tutti i
diritti riservati.

Tutti i nomi commerciali e dei prodotti delle aziende citati nei prodotti Brother, i relativi documenti e
qualsiasi altro materiale sono marchi o marchi registrati delle rispettive aziende.

  Informazioni correlate

• Prima di utilizzare la macchina Brother 
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Osservazioni sulle licenze open source
Questo prodotto contiene del software open source.
Per consultare le Osservazione sulle licenze open source, accedere alla pagina Manuali del modello in uso sul
sito Web di supporto Brother all'indirizzo support.brother.com.

  Informazioni correlate

• Prima di utilizzare la macchina Brother 
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Nota importante
• Il contenuto di questo documento e le specifiche di questo prodotto sono soggetti a modifiche senza

preavviso.
• Brother si riserva il diritto di apportare modifiche senza preavviso alle specifiche e ai materiali qui contenuti e

non potrà essere in alcun modo ritenuta responsabile di eventuali danni (inclusi quelli indiretti) causati
dall'affidamento riposto nei materiali presentati, inclusi, a titolo esemplificativo ma non esaustivo, gli errori
tipografici e di altro tipo eventualmente contenuti nelle pubblicazioni.

• Le immagini delle schermate riportate in questo documento possono differire a seconda del sistema
operativo del computer, del modello del prodotto e della versione del software.

• Prima di utilizzare la stampante, accertarsi di leggere tutta la documentazione fornita con la stessa, per
informazioni sulla sicurezza e sull'utilizzo corretto.

• La stampante mostrata nelle illustrazioni potrebbe essere diversa dalla stampante in uso.
• Le forniture disponibili possono variare a seconda del paese.
• Consigliamo di usare l'ultima versione di P-touch Editor.

  Informazioni correlate

• Prima di utilizzare la macchina Brother 
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Configurazione della stampante

• Descrizione dei componenti

• Caricamento del rotolo RD

• Controllare la posizione del sensore

• Collegamento del cavo di alimentazione

• Accensione/spegnimento
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Descrizione dei componenti

Lato anteriore

2

3

1

8

9

7 6

4

5

1. Fessura di uscita delle etichette
2. Coperchio del vano del rotolo
3. Barra di strappo
4. LED di stato
5. LED del rotolo

6. Pulsante  (Funzione)

7. Pulsante  (Avanzamento)

8. Pulsante  (Alimentazione)

9. LED alimentazione

Per mettere in pausa la stampa, premere un pulsante qualsiasi. Premere nuovamente il pulsante per
riprendere la stampa. È possibile mettere in pausa la stampa solo dopo che è stata stampata ogni pagina
intera; la stampa non può essere messa in pausa alla pagina finale o tra pagine.

Lato posteriore

1

3
4

2

1. Porta di alimentazione
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2. Porta seriale
3. (TD-4420DN/TD-4520DN) Porta LAN
4. Porta USB

  Informazioni correlate

• Configurazione della stampante 
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Caricamento del rotolo RD

1. Premere e tenere premuto  per spegnere la stampante.

2. Tirare le leve di rilascio su entrambi i lati della stampante per sbloccare il coperchio del vano del rotolo.

3. Afferrare la stampante dal lato anteriore e sollevare con decisione il coperchio del vano del rotolo per aprirlo.

  ATTENZIONE
Non toccare direttamente il Barra di strappo con le dita. Il mancato rispetto di questa avvertenza potrebbe
provocare lesioni.

4. Far scorrere entrambe le guide del rotolo verso l'esterno.
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Per bloccare le guide del rotolo al loro posto, ruotare la ghiera del regolatore verso se stessi.

5. Inserire il rotolo in modo tale che le etichette vengano inserire con il lato di stampa rivolto verso l'alto, come
nell'illustrazione.

• Per la carta a modulo continuo
Inserire la carta a modulo continuo come mostrato nell'illustrazione.

a. Lato di stampa
Per carta a modulo continuo, regolare le guide del rotolo.

6. Inserire l'estremità del rotolo sotto le guide inizio supporto di stampa (1).
Posizionare l'estremità della carta leggermente al di fuori della fessura di uscita delle etichette.
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7. Chiudere il coperchio del vano del rotolo fino a quando non si blocca al proprio posto.

  ATTENZIONE
Chiudere il coperchio del vano del rotolo con attenzione. Vi è il rischio di lesioni qualora il dito resti
schiacciato tra la parte superiore e quella inferiore del coperchio.

IMPORTANTE

• Non lasciare le etichette stampate nella stampante. Così facendo, le etichette potrebbero incepparsi.
• Quando non in uso, rimuovere i rotoli dall'interno della stampante e chiudere il coperchio del vano del

rotolo per prevenire la formazione di polvere e detriti nella stampante.

  Informazioni correlate

• Configurazione della stampante 
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Controllare la posizione del sensore
Se si utilizzano RD o altri tipi di rotoli, è necessario controllare la posizione del sensore sulla base del tipo di
carta che si utilizza. Oltre ai rotoli RD, è possibile utilizzare altri tipi di rotoli.
>> Etichette pretagliate senza segno nero
>> Etichette pretagliate con segno nero
>> Carta per ricevute senza segno nero
>> Supporto con segno nero
>> Supporto con fori
>> Cinturini

Etichette pretagliate senza segno nero

Il sensore trasmissivo/distanza rileva l'inizio dell'etichetta e la fa avanzare fino alla posizione corretta.
• Allineare il dispositivo di slittamento con b sulla stampante.

Etichette pretagliate con segno nero

Il sensore riflettente/segno nero rileva il segno e fa avanzare il supporto fino alla posizione corretta.
• Allineare il dispositivo di slittamento come mostrato nell'illustrazione.

2

3

1

1. Retro del supporto di stampa
2. Segno nero
3. Sensore riflettente/segno nero

Carta per ricevute senza segno nero

Il sensore riflettente/segno nero rileva la fine del rotolo di carta.
• Allineare il dispositivo di slittamento con b sulla stampante.

Supporto con segno nero

Il sensore riflettente/segno nero rileva il segno e fa avanzare il supporto fino alla posizione corretta.
• Allineare il dispositivo di scorrimento con il centro del segno nero sulla carta.
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1. Retro del supporto di stampa
2. Segno nero
3. almeno 4 mm

Assicurarsi che siano presenti almeno 4 mm a sinistra e a destra del centro del segno nero.
4. Centro del segno nero
5. Sensore riflettente/segno nero

Quando si utilizza il supporto di larghezza massima di 118 mm, tracciare un segno nero lungo almeno
12 mm dal bordo sinistro o destro della carta, in modo tale che il sensore riflettente/segno nero possa
rilevare il segno nero. Se il segno nero è troppo corto non può essere rilevato dal sensore riflettente/segno
nero.

Supporto con fori

Il sensore riflettente/segno nero rileva il foro e fa avanzare il supporto fino alla posizione corretta.
• Allineare il dispositivo di slittamento come mostrato nell'illustrazione.

2

3

1

1. Retro del supporto di stampa
2. Foro nel supporto
3. Sensore riflettente/segno nero

Cinturini

Il sensore riflettente/segno nero rileva il segno e fa avanzare il supporto fino alla posizione corretta.
• Allineare il dispositivo di slittamento come mostrato nell'illustrazione.

3

1

2

1. Retro del supporto di stampa
2. Segno nero
3. Sensore riflettente/segno nero
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  Informazioni correlate

• Configurazione della stampante

Argomenti correlati:
• Configurazione supporto automatica 
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Collegamento del cavo di alimentazione
1. Collegare l'adattatore CA alla stampante.
2. Collegare il cavo di alimentazione CA all'adattatore CA.
3. Inserire il cavo di alimentazione CA in una presa elettrica dotata di messa a terra.

  Informazioni correlate

• Configurazione della stampante 
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Accensione/spegnimento

• Per accendere la stampante, premere .

Per allineare la fine del rotolo, premere .

Si accende il LED dell'alimentazione verde.

• Per spegnere la stampante, premere e tenere premuto  fino a che il LED dell'alimentazione si spegne.

NOTA
Quando si spegne la stampante, non scollegare l'adattatore CA e il cavo di alimentazione CA fino a che il
LED dell'alimentazione non si è spento.

  Informazioni correlate

• Configurazione della stampante 
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Installazione del software

• Installare i driver e il software della stampante su un computer

• Connettere la stampante a un computer
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Installare i driver e il software della stampante su un computer
Per stampare da un computer, installare sul computer il driver stampante, P-touch Editor e altre applicazioni.
1. Andare su install.brother e scaricare il programma di installazione del software/la documentazione.
2. Fare doppio clic sul programma di installazione scaricato e seguire le istruzioni a schermo per procedere con

l'installazione.

3. Al termine dell'installazione, chiudere la finestra di dialogo.

(TD-4420DN/TD-4520DN)
Per usare la stampante con un metodo di connessione diverso da quello selezionato durante l'installazione,
è necessario utilizzare nuovamente il programma di installazione per reinstallare il software e i driver della
stampante, quindi selezionare il nuovo metodo di connessione.

  Informazioni correlate

• Installazione del software

• Applicazioni disponibili 
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Applicazioni disponibili

Applicazioni disponibili per Windows

Applicazione Funzioni

P-touch Editor Consente di progettare e stampare etichette personalizzate mediante gli strumenti di disegno
integrati per creare font e stili di testo diversi, importare immagini e inserire i codici a barre.

P-touch Transfer
Manager

Consente di trasferire modelli e altri dati alla stampante e di salvare backup dei dati nel
computer.
Questa applicazione viene installata con P-touch Editor.

P-touch Library Gestisce e stampa i modelli di P-touch Editor.
È possibile utilizzare P-touch Library per stampare i modelli.
Questa applicazione viene installata con P-touch Editor.

P-touch Update
Software

Consente di aggiornare il software alla versione più recente.

Strumento di
impostazione della
stampante

Consente di specificare le impostazioni della stampante da un computer.

BRAdmin Light
(TD-4420DN/
TD-4520DN)

Individua la stampante sulla rete e consente di configurare le impostazioni di base dal
computer.

BRAdmin
Professional
(TD-4420DN/
TD-4520DN)

Individua la stampante sulla rete e consente di configurare le impostazioni avanzate e gli
aggiornamenti dal computer.

Font Manager Consente di trasferire i font alla stampante e di eliminarli dalla stampante. È possibile accedere
ai font trasferiti e stamparli utilizzando vari comandi di stampa.

• Informazioni sull'autorizzazione all'uso dei font
Per utilizzare i font, è necessario accettare tutti i termini e le condizioni richiesti dal
proprietario legittimo di ogni font. Prima di scaricare i font, confermare di disporre
delle licenze d'uso legittime per l'utilizzo dei font e rispettare i relativi termini e
condizioni; in caso contrario non sarà possibile scaricare i font.

  Informazioni correlate

• Installare i driver e il software della stampante su un computer 
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Connettere la stampante a un computer

• Collegamento della stampante a un computer mediante un cavo USB

• Collegamento della stampante a un computer mediante una LAN cablata
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Collegamento della stampante a un computer mediante un cavo USB
1. Prima di collegare il cavo USB, assicurarsi che la stampante sia spenta.
2. Collegare il cavo USB alla porta USB sul retro della stampante, quindi al computer in uso.

3. Accendere la stampante.

  Informazioni correlate

• Connettere la stampante a un computer 
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Collegamento della stampante a un computer mediante una LAN
cablata

Modelli correlati: TD-4420DN/TD-4520DN

Per usare un indirizzo IP statico per collegare la stampante a una connessione LAN cablata, installare i driver
stampante e lo Strumento di impostazione della stampante, quindi specificare le impostazioni della connessione
LAN.
Cavo di rete
Usare un cavo intermedio a doppino intrecciato Categoria 5 (o superiore) per reti 10BASE-T o 100BASE-TX Fast
Ethernet.

IMPORTANTE

Non collegare il prodotto a una rete LAN soggetta a sovratensioni.

1. Se durante l'installazione vengono visualizzate le istruzioni a schermo, prima di collegare il cavo LAN
assicurarsi che la stampante sia spenta.

2. Collegare il cavo LAN alla porta LAN posta sul retro della stampante.
3. Accendere la stampante.

  Informazioni correlate

• Connettere la stampante a un computer 
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Creazione di etichette e stampa mediante computer

• Creazione di etichette utilizzando P-touch Editor (Windows)

• Stampa di etichette usando P-touch Editor (Windows)

• Creazione di etichette e stampa senza installare software e driver

• Stampa di etichette distribuita su più stampanti per ridurre i tempi di stampa (Windows)

• Stampa di etichette codici a barre utilizzando Ritaglio stampa (Windows)

• Stampa di etichette mediante il driver stampante (Windows)
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Creazione di etichette utilizzando P-touch Editor (Windows)
Per utilizzare la stampante con il computer è necessario installare P-touch Editor e il driver stampante.
Per i driver e i software più recenti, accedere alla pagina del modello Download sul sito Web di supporto Brother
all'indirizzo support.brother.com.

1. Avviare P-touch Editor .

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Editor 5.2 o doppio clic sull'icona P-touch Editor 5.2 sul
desktop.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Editor 5.2 nella schermata Applicazioni oppure fare doppio clic sull'icona P-
touch Editor 5.2 sul desktop.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Editor 5.2 o
doppio clic sull'icona P-touch Editor 5.2 sul desktop.

Si avvia P-touch Editor.
2. Effettuare una delle seguenti operazioni:

• Per aprire un layout esistente, fare clic su Apri (1).
• Per collegare un layout predefinito a un database, selezionare la casella di controllo accanto a Connetti

database (2).
• Per creare un nuovo layout, fare doppio clic sul riquadro Nuovo layout (3) oppure fare clic sul riquadro

Nuovo layout (3) e quindi su →.
• Per creare un nuovo layout usando un layout predefinito, fare doppio clic su un pulsante di categoria (4)

oppure selezionare un pulsante di categoria (4) e poi fare clic su →.

21
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Per modificare il funzionamento di P-touch Editor all'avvio, fare clic su Strumenti > Opzioni nella barra dei
menu di P-touch Editor per visualizzare la finestra di dialogo Opzioni. Sul lato sinistro, selezionare
l'intestazione Generali, quindi l'impostazione desiderata nella casella di riepilogo Operazioni sotto
Impostazioni di avvio.

  Informazioni correlate

• Creazione di etichette e stampa mediante computer

• Finestra principale della modalità Express di P-touch Editor (Windows)
• Finestra principale della modalità Professional di P-touch Editor (Windows)
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• Finestra principale della modalità Snap di P-touch Editor (Windows) 
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 Pagina Iniziale > Creazione di etichette e stampa mediante computer > Creazione di etichette utilizzando P-
touch Editor (Windows) > Finestra principale della modalità Express di P-touch Editor (Windows)

Finestra principale della modalità Express di P-touch Editor (Windows)
La modalità Express consente di creare rapidamente layout contenenti testo e immagini.

1 12

3

4

1. Barre degli strumenti di modifica
2. Pulsante Stampa
3. Pulsanti di selezione della modalità di funzionamento
4. Palette delle proprietà

  Informazioni correlate

• Creazione di etichette utilizzando P-touch Editor (Windows) 
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touch Editor (Windows) > Finestra principale della modalità Professional di P-touch Editor (Windows)

Finestra principale della modalità Professional di P-touch Editor
(Windows)

La modalità Professional consente di creare layout utilizzando un'ampia gamma di strumenti e opzioni avanzati.

1 2

3

4

3

1. Menu Stampa
2. Palette delle proprietà
3. Barre degli strumenti di modifica
4. Pulsanti di selezione della modalità di funzionamento

  Informazioni correlate

• Creazione di etichette utilizzando P-touch Editor (Windows) 
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Finestra principale della modalità Snap di P-touch Editor (Windows)
La modalità Snap consente di catturare interamente o in parte il contenuto della schermata del computer e di
stamparlo.

  Informazioni correlate

• Creazione di etichette utilizzando P-touch Editor (Windows) 
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 Pagina Iniziale > Creazione di etichette e stampa mediante computer > Stampa di etichette usando P-touch
Editor (Windows)

Stampa di etichette usando P-touch Editor (Windows)

>> Modalità Express
>> Modalità Professional
>> Modalità Snap

Modalità Express

Prima di stampare, configurare le impostazioni di stampa nella schermata Stampa.

• Fare clic su File > Stampa dalla barra dei menu oppure fare clic su  (Stampa).

Modalità Professional

Prima di stampare, configurare le impostazioni di stampa nella schermata Stampa.

• Fare clic su File > Stampa dalla barra dei menu oppure fare clic su .

Fare clic su  per avviare la stampa senza modificare le impostazioni.

Modalità Snap

• Immettere il testo, quindi fare clic su .

  Informazioni correlate

• Creazione di etichette e stampa mediante computer 
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 Pagina Iniziale > Creazione di etichette e stampa mediante computer > Creazione di etichette e stampa
senza installare software e driver

Creazione di etichette e stampa senza installare software e driver

• Stampa tramite interfaccia USB (modalità di archiviazione di massa)

• Stampa dei dati di immagine senza utilizzare il driver stampante
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Stampa tramite interfaccia USB (modalità di archiviazione di massa)
La modalità di archiviazione consente di inviare un file alla stampante mediante l'interfaccia USB, senza
installare un driver stampante.

Questa funzionalità è utile per:
• Applicare le impostazioni della stampante salvate in un file di comando (formato file BIN) e aggiungere dei

modelli (formato file BLF) nella stampante senza la necessità di utilizzare strumenti software. Entrambi i tipi di
file devono essere distribuiti da un amministratore.

• Eseguire dei comandi senza installare il driver della stampante.
• Utilizzare un dispositivo con un sistema operativo (compresi i sistemi operativi diversi da Windows) che

dispone di una funzionalità host USB per stampare e trasmettere dati.
1. Verificare che la stampante sia spenta.

2. Mentre si preme , premere .

L'indicatore LED di alimentazione diventa verde.
3. Collegare il computer o il dispositivo mobile alla stampante tramite USB.

Sullo schermo del computer o del dispositivo l'area di archiviazione di massa della stampante viene
visualizzata come una cartella.

Se l'area di archiviazione di massa non è visualizzata automaticamente, consultare le istruzioni relative al
sistema operativo del computer o del dispositivo per effettuare l'accesso all'area di archiviazione di massa.

4. Trascinare e rilasciare il file da copiare sull'area di archiviazione di massa.

5. Premere .

Vengono eseguiti i comandi specificati nel file dei comandi e l'indicatore LED di stato lampeggia una volta in
verde. Al termine, l'indicatore LED di alimentazione diventa verde.

6. Per disattivare la modalità di archiviazione di massa, spegnere la stampante.

NOTA
• Quando la stampante è spenta, la modalità di archiviazione di massa è disattivata e gli eventuali file

presenti al suo interno vengono eliminati.
• Questa funzionalità supporta i file BIN e BLF.
• Non creare cartelle di un'area di archiviazione di massa. Se viene creata una cartella, non sarà possibile

accedere ai file in essa contenuti.
• La capacità dell'area di archiviazione di massa è di 16 MB.
• Se vengono copiati più file, i comandi potrebbero non venire eseguiti.
• Quando la stampante è in modalità di archiviazione di massa è disponibile solo il collegamento USB.
• Quando si esegue un file copiato, non accedere ad altri file nell'area di archiviazione di massa.

  Informazioni correlate

• Creazione di etichette e stampa senza installare software e driver 
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Stampa dei dati di immagine senza utilizzare il driver stampante

• La funzione di archiviazione di massa supporta la stampa delle immagini JPEG.
• La stampante converte un'immagine a colori JPEG in un'immagine monocromatica utilizzando un

processo di dithering.
• Quando si invia un'immagine JPEG monocromatica, il processo di dithering potrebbe rendere sbiadita

l'immagine stampata.
• Per migliorare la qualità dell'immagine, provare a disattivare eventuali funzionalità di pre-elaborazione

dell'immagine JPEG.

• Possono essere stampate soltanto immagini JPEG. (Limitatamente ai file con estensione .jpg.)
• Le dimensioni massime del file sono di 16 MB.

(2 MB quando viene utilizzata la funzionalità di archiviazione di massa.)
• La risoluzione massima è:

- TD-4410D/TD-4420DN
Altezza × Larghezza = 24.000 × 832 punti

- TD-4520DN
Altezza × Larghezza = 36.000 × 1.280 punti

Se questi limiti vengono superati, i dati ricevuti dalla stampante saranno ignorati e non verranno stampati.
• Stampa con 1 pixel = 1 punto.
• Per stampare l'immagine, la stampante esegue l'elaborazione binaria (binaria semplice).
• L'immagine viene stampata con la proporzione altezza-larghezza dei dati ricevuti.

  Informazioni correlate

• Creazione di etichette e stampa senza installare software e driver 
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più stampanti per ridurre i tempi di stampa (Windows)

Stampa di etichette distribuita su più stampanti per ridurre i tempi di
stampa (Windows)

Quando si stampa un numero elevato di etichette, la stampa può essere distribuita tra più stampanti tramite un
collegamento USB o di rete, per ridurre i tempi di stampa.

• La funzione di stampa distribuita può essere utilizzata solo con stampanti con lo stesso numero
modello.

• Il numero di pagine viene suddiviso tra le stampanti selezionate. Se il numero di pagine specificato non
può essere suddiviso uniformemente tra le stampanti, verrà suddiviso nell'ordine delle stampanti come
mostrato.

67 67 66

200

• Per una stampante collegata mediante un hub USB o un server di stampa, potrebbe non essere
possibile rilevare le informazioni. Prima di stampare, immettere manualmente le impostazioni e
verificare se la stampante può essere usata per la stampa.

• (TD-4420DN/TD-4520DN)
A seconda dell'utilizzo o meno di un router e delle funzioni di sicurezza in uso, come ad esempio un
firewall, potrebbe non essere possibile utilizzare questa funzione.

• Si consiglia di eseguire un test di connessione per il proprio ambiente operativo. Per assistenza,
contattare un responsabile IT o un amministratore.

1. In P-touch Editor, fare clic su File > Stampa.
2. Fare clic su Proprietà.
3. Fare clic sulla scheda Avanzate, selezionare la casella di controllo Stampa distribuita, quindo fare clic su

Impostazioni.

Viene visualizzata la finestra di dialogo Impostazioni di stampa distribuita.
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4. Selezionare le stampanti da utilizzare per la stampa distribuita.

(TD-4420DN/TD-4520DN)
Se sono collegate più stampanti, è possibile trovare la stampante desiderata in base al relativo nome di
porta. L'indicazione xxxxxxxxxxxx in BRNxxxxxxxxxxxx nel nome di porta indica l'indirizzo MAC/indirizzo
Ethernet della stampante. L'indirizzo MAC/indirizzo Ethernet può essere controllato stampando i dati di
impostazione della stampante.

5. Fare clic con il pulsante destro del mouse sulla stampante o sulle stampanti selezionate, quindi fare clic su
Impostazioni. Dall'elenco a discesa Formato carta, selezionare le dimensioni dell'etichetta.
Se sono state selezionate più stampanti, a tutte queste stampanti verrà applicata la stessa impostazione di
dimensione dell'etichetta.

6. Fare clic su OK per chiudere la finestra di dialogo dell'impostazione delle dimensioni dell'etichetta.
7. Fare clic su OK per chiudere la finestra di dialogo Impostazioni di stampa distribuita.

L'impostazione è completata.
8. Fare clic su OK per chiudere la finestra di dialogo Proprietà.
9. Avviare stampa.

  Informazioni correlate

• Creazione di etichette e stampa mediante computer 
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 Pagina Iniziale > Creazione di etichette e stampa mediante computer > Stampa di etichette codici a barre
utilizzando Ritaglio stampa (Windows)

Stampa di etichette codici a barre utilizzando Ritaglio stampa
(Windows)

Modelli correlati: TD-4520DN

È possibile stampare uno o più codici a barre da un file PDF di grandezza A4 o Letter. La funzione Ritaglio
stampa individua automaticamente i codici a barre specificati, che poi ritaglia e stampa singolarmente.

A

B

A

B

C

Z

C

D00XXU001 D00VXY004 D00ZXX003

D00XXU001

D00XXU001

D00XXU002 D00X0X001 D00ZXX004

D00XXU003 D00X0X002 D00KYX001

D00XXU004 D00X0X003 D00KYX002

D00VXY001 D00X0X004 D00KYX003

D00VXY002 D00ZXX001 D00KYX004

D00VXY003 D00ZXX002 D00XXX001

XXXXXXXX

xxxxxxxxxxxxxxxxxxxxx

xxxxxxxxxxxxxxxxxxxxx

xxxxxxxxxxxxxxxxxxxxx

xxxxxxxxxxxxxxxxxxxxx

xxxxxxxxxxxxxxxxxxxxx

xxxxxxxxx

D00XXU001

D00XXU002

D00XXU003

D00XXX001
Z

• La funzione Ritaglio stampa è disponibile solo quando si stampa dal driver stampante di Windows e non
può essere eseguita usando P-touch Editor.

• L'accuratezza della funzione Ritaglio stampa dipende dall'ambiente dell'utente, dal materiale di stampa
e dal contenuto dell'etichetta.
Si consiglia di utilizzare codici a barre chiari e in bianco e nero.
Alcune etichette potrebbero non venire stampate correttamente o potrebbero differire dai dati originali in
caso di condizioni non ottimali.
Per ulteriori informazioni, visitare il sito Web di supporto Brother alla pagina support.brother.com.

  Informazioni correlate

• Creazione di etichette e stampa mediante computer

• Codici a barre compatibili con Ritaglio stampa (Windows)
• Documento con codici a barre compatibile con Ritaglio stampa (Windows)
• Stampa di etichette codici a barre utilizzando Ritaglio stampa (Windows) 
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Codici a barre compatibili con Ritaglio stampa (Windows)

Modelli correlati: TD-4520DN

Specifiche dei codici a barre

Proprietà Specifica

Larghezza verticale 5 mm (minimo)

Larghezza orizzontale La barra più stretta: 0,5 mm (minimo)

Margine 10 volte la larghezza della barra più stretta (minimo)

Colore Nero

Colore di sfondo Bianco

Larghezza cella (barra più larga) 0,5 mm (minimo)

• Codice 39/Codice 3 di 9
• ITF/ITF-14/interlacciato 2 di 5
• GS1-128 (UCC/EAN-128)
• Codabar (codice 2 di 7, NW-7)
• CODICE 93
• CODICE 128
• UPC-A
• UPC-E
• JAN-8/EAN-8
• JAN-13/EAN-13

• Codice QR 1

• Datamatrix / GS1 Datamatrix 1

• PDF417 1

• MaxiCode 1

  Informazioni correlate

• Stampa di etichette codici a barre utilizzando Ritaglio stampa (Windows) 

1 disponibile per le etichette di spedizione

37



 Pagina Iniziale > Creazione di etichette e stampa mediante computer > Stampa di etichette codici a barre
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(Windows)

Documento con codici a barre compatibile con Ritaglio stampa
(Windows)

Modelli correlati: TD-4520DN

Per utilizzare la funzione Ritaglio stampa, creare un documento codice a barre e salvarlo in formato PDF.
Accertarsi che il file PDF del codice a barre finale soddisfi i seguenti requisiti:

Condizioni dei codici a barre per le etichette prodotto

Elemento Condizione

Numero totale di codici a
barre

Tra 1 e 99 codici a barre.

Tipo di codice a barre Utilizzare solo i codici a barre compatibili con la funzione Ritaglio stampa.

Posizione dei codici a barre Accertarsi che i codici a barre non siano inclinati o in posizione angolata. Devono
essere paralleli alla parte superiore e alla parte inferiore di ogni pagina.
Accertarsi che i codici a barre inizino nell'angolo sinistro superiore e scorrano in basso
lungo la colonna, continuando nella parte superiore della successiva colonna a destra.

Layout dei codici a barre per le etichette prodotto

Layout corretto dei codici a barre Layout errato dei codici a barre

D00XXU001 D00VXY004 D00ZXX003

D00XXU002 D00X0X001

D00XXU003 D00X0X002

D00XXU004 D00X0X003

D00VXY001 D00X0X004

D00VXY002 D00ZXX001

D00VXY003 D00ZXX002

Non identificato
(non allineato al margine superiore)

D00XXU001

D00XXU002 D00X0X001

D00XXU003 D00X0X002 D00KYX001

D00XXU004 D00X0X003 D00KYX002

D00VXY001 D00X0X004 D00KYX003

D00VXY002 D00ZXX001 D00KYX004

D00VXY003 D00ZXX002 D00XXX001

Condizioni dei codici a barre per le etichette di spedizione

Elemento Condizione

Numero totale di codici a barre Tra 1 e 9 codici a barre

Tipo di codice a barre Utilizzare solo i codici a barre compatibili con la funzione Ritaglio stampa.

Posizione dei codici a barre Accertarsi che i codici a barre siano dritti.

Layout dei codici a barre per le etichette di spedizione
Il ritaglio viene eseguito quando si verifica una delle seguenti condizioni:
• L'etichetta viene circondata da righe.
• L'etichetta include righe orizzontali che ne estendono la larghezza totale.
• L'etichetta include righe verticali che ne estendono la lunghezza totale.
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Layout corretto dei codici a barre

  Informazioni correlate

• Stampa di etichette codici a barre utilizzando Ritaglio stampa (Windows) 
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utilizzando Ritaglio stampa (Windows) > Stampa di etichette codici a barre utilizzando Ritaglio stampa
(Windows)

Stampa di etichette codici a barre utilizzando Ritaglio stampa
(Windows)

Modelli correlati: TD-4520DN

Accertarsi che la stampante sia collegata a un computer o a un dispositivo mobile mediante cavo USB o un
collegamento di rete.

1. Aprire il file PDF del documento codice a barre da stampare.
2. Fare clic su File > Stampa.
3. Fare clic sull'elenco a discesa Stampante e selezionare la stampante desiderata.
4. Nella sezione Gestione e dimensioni pagina, selezionare il pulsante di scelta Dimensioni effettive.
5. In Orientamento, selezionare il pulsante di scelta Verticale.
6. Fare clic su Proprietà.
7. Fare clic sulla scheda Base ed effettuare una delle seguenti operazioni:

• Per le etichette pretagliate, cancellare la casella di controllo Taglia ogni.
• Per i rulli continui, selezionare la casella di controllo Taglia ogni.

8. Fare clic sulla scheda Ritaglio stampa e selezionare la casella di controllo Stampa automaticamente le
singole etichette con i codici a barre..

9. Selezionare l'opzione Estrai etichette singole con codice a barre per le etichette prodotto o l'opzione
Ritaglia codici a barre, testo e altri oggetti per le etichette di spedizione.
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10. Fare clic sull'elenco a discesa Formato etichetta/carta, quindi selezionare l'etichetta o il formato carta.
Se si seleziona l'opzione Ritaglia codici a barre, testo e altri oggetti, viene elencata solo la carta con
larghezza 102 mm.

Selezionare le dimensioni di etichetta che più si avvicinano alle dimensioni originali dei dati di ritaglio. È
consigliabile eseguire una prova prima di stampare un gran numero di etichette.

11. Fare clic su OK.
12. Stampa dalla schermata di stampa dell'applicazione.

• Non ingrandire o ridurre le dimensioni del foglio codice a barre. I codici a barre potrebbero non essere
individuati correttamente.

• Quando si stampa da Acrobat Reader, effettuare le seguenti operazioni:
- Nella sezione Gestione e dimensioni pagina, deselezionare la casella di controllo Scegli

alimentazione secondo dimensioni pagina PDF.
- In Orientamento, selezionare il pulsante di scelta Verticale.

  Informazioni correlate

• Stampa di etichette codici a barre utilizzando Ritaglio stampa (Windows) 
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 Pagina Iniziale > Creazione di etichette e stampa mediante computer > Stampa di etichette mediante il
driver stampante (Windows)

Stampa di etichette mediante il driver stampante (Windows)
1. Connettere la stampante a un computer.
2. Aprire il documento da stampare.
3. Selezionare il comando di stampa nell'applicazione.
4. Selezionare la stampante, quindi fare clic sul pulsante delle proprietà o delle preferenze di stampa.

Viene visualizzata la finestra del driver stampante.
5. Modificare le impostazioni della stampante, se necessario.
6. Fare clic su OK.
7. Completare l'operazione di stampa.

La stampante inizia a stampare. Al termine della stampa, la stampante torna alla modalità selezionata prima
dell'avvio della stampa.

  Informazioni correlate

• Creazione di etichette e stampa mediante computer 
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 Pagina Iniziale > Stampa di etichette mediante dispositivi mobili

Stampa di etichette mediante dispositivi mobili

• Installazione delle applicazioni mobili
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 Pagina Iniziale > Stampa di etichette mediante dispositivi mobili > Installazione delle applicazioni mobili

Installazione delle applicazioni mobili
È possibile usare la stampante come stampante autonoma o collegarla a un dispositivo mobile. Per creare e
stampare etichette direttamente dal dispositivo mobile, installare le applicazioni mobili Brother, quindi collegare la
stampante al dispositivo mobile tramite un cavo USB. Il cavo è venduto separatamente.
• Scaricare queste applicazioni Brother gratuitamente da Google Play:

Applicazione Funzioni

SDK stampa Scaricare il kit di sviluppo del software (SDK, Software Development Kit) dal
Brother Developer Center (brother.com/product/dev).

  Informazioni correlate

• Stampa di etichette mediante dispositivi mobili 
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 Pagina Iniziale > Trasferimento dei modelli alla stampante (P-touch Transfer Manager) (Windows)

Trasferimento dei modelli alla stampante (P-touch Transfer Manager)
(Windows)

• Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows)

• Distribuire i modelli da trasferire agli utenti senza P-touch Transfer Manager (Windows)
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 Pagina Iniziale > Trasferimento dei modelli alla stampante (P-touch Transfer Manager)
(Windows) > Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows)

Trasferimento dei modelli alla stampante mediante P-touch Transfer
Manager (Windows)

• Note sull'uso di P-touch Transfer Manager (Windows)

• Trasferimento di modelli dal computer alla stampante (Windows)

• Backup dei modelli o di altri dati memorizzati nella stampante (Windows)

• Eliminazione di dati dalla stampante (Windows)

• Creazione di file di trasferimento e di file pacchetto di trasferimento (Windows)
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Note sull'uso di P-touch Transfer Manager (Windows)
Poiché alcune funzioni di P-touch Editor non sono disponibili sulla stampante, quando si usa P-touch Editor per
creare modelli, tenere presente quanto segue.
È possibile controllare un'anteprima del modello stampato prima che il modello creato venga trasferito alla
stampante.

Note sulla creazione di modelli
• Una parte del testo del modello trasferito alla stampante potrebbe essere stampata usando dimensioni di font

e carattere simili caricate nella stampante. Di conseguenza, l'etichetta stampata potrebbe differire
dall'immagine del modello creato in P-touch Editor.

• A seconda dell'impostazione dell'oggetto testo, le dimensioni dei caratteri potrebbero venire ridotte
automaticamente oppure una parte del testo potrebbe non venire stampata. In tal caso, modificare
l'impostazione dell'oggetto testo.

• Anche se con P-touch Editor gli stili dei caratteri possono essere applicati a singoli caratteri, essi possono
essere applicati a un blocco di testo solo tramite la stampante. Inoltre, alcuni stili di caratteri non sono
disponibili sulla stampante.

• Gli sfondi specificati con P-touch Editor non sono compatibili con la stampante.
• Un layout P-touch Editor che utilizza la funzione di stampa divisa (ingrandendo l'etichetta e stampandola su

due o più etichette) non può essere trasferito.
• Viene stampata solo la porzione di etichetta all'interno dell'area stampabile.
• I campi che superano l'area di stampa potrebbero non venire stampati completamente.

Note sul trasferimento di modelli
• L'etichetta stampata potrebbe differire dall'immagine visualizzata nell'area di anteprima di P-touch Transfer

Manager.
• Se un codice a barre bidimensionale non caricato nella stampante viene trasferito alla stampante, viene

convertito in immagine. L'immagine del codice a barre convertito non può essere modificata.
• Tutti gli oggetti trasferiti che non possono essere modificati dalla stampante vengono convertiti in immagini.
• Gli oggetti raggruppati sono convertiti in una singola bitmap.

Note sul trasferimento dei dati diversi dai modelli
• Se il numero o l'ordine dei campi in un database viene modificato e solo il database (file CSV) viene trasferito

per aggiornarlo, il database potrebbe non collegarsi correttamente con il modello. Inoltre, la prima riga di dati
del file trasferito deve essere riconosciuta dalla stampante come "nomi di campo".

• I loghi, i simboli e la grafica scaricati sulla stampante vengono scalati automaticamente al font residente o a
uno qualsiasi dei simboli residenti nella libreria.

  Informazioni correlate

• Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows) 
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Trasferimento di modelli dal computer alla stampante (Windows)
È possibile trasferire modelli e altri dati alla stampante e salvare backup dei dati nel computer.
Per utilizzare P-touch Transfer Manager, è necessario trasferire prima i modelli creati in P-touch Editor su P-
touch Transfer Manager.

  Informazioni correlate

• Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows)

• Trasferimento del modello a P-touch Transfer Manager (Windows)
• Finestra principale di P-touch Transfer Manager (Windows)
• Trasferire modelli o altri dati dal computer alla stampante (Windows) 
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P-touch Transfer Manager (Windows)

Trasferimento del modello a P-touch Transfer Manager (Windows)

1. Avviare P-touch Editor .

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Editor 5.2 o doppio clic sull'icona P-touch Editor 5.2 sul
desktop.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Editor 5.2 nella schermata Applicazioni oppure fare doppio clic sull'icona P-
touch Editor 5.2 sul desktop.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Editor 5.2 o
doppio clic sull'icona P-touch Editor 5.2 sul desktop.

Si avvia P-touch Editor.
2. Aprire il modello desiderato o creare un layout etichetta.
3. Fare clic su File > Trasferisci modello > Trasferisci.

Viene visualizzata la finestra di P-touch Transfer Manager. Un modello viene trasferito nella cartella
Configurazioni.

  Informazioni correlate

• Trasferimento di modelli dal computer alla stampante (Windows) 
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Transfer Manager (Windows)

Finestra principale di P-touch Transfer Manager (Windows)

2

4

1

3

5

6

1. Barra dei menu
Consente di accedere ai diversi comandi, suddivisi per titolo del menu (menu File, Modifica, Visualizza,
Strumenti e ?) in base alle rispettive funzioni.

2. Area di selezione della stampante
Consente di selezionare una stampante su cui trasferire i dati. Quando si seleziona una stampante,
nell'elenco dati vengono visualizzati solo i dati che è possibile inviare alla stampante selezionata.

3. Elenco modelli
Visualizza un elenco di modelli nella cartella selezionata.

4. Anteprima
Visualizza un'anteprima dei modelli contenuti nell'elenco modelli.

5. Elenco cartelle
Visualizza un elenco di cartelle e stampanti. Quando si seleziona una cartella, i modelli contenuti nella
cartella selezionata vengono visualizzati nell'elenco modelli. Se si seleziona una stampante, vengono
visualizzati i modelli correnti e altri dati memorizzati nella stampante.

6. Barra degli strumenti
Consente di accedere ai comandi di uso frequente.

Spiegazione delle icone della barra degli strumenti

Icona Nome pulsante Funzione

Trasferisci Trasferisce modelli e altri dati dal computer alla stampante.

Salva file di trasferimento
(Quando non è collegata una
stampante)

Modifica il tipo di file dei dati da trasferire in altre applicazioni.
Selezionare BLF per l'estensione del nome file quando si
stampano le etichette utilizzando la modalità di archiviazione di
massa (USB) o quando si trasferiscono i dati utilizzando
BRAdmin Professional (LAN). Quando si trasferiscono dati
tramite Transfer Express (USB), selezionare PDZ.
Le interfacce disponibili variano a seconda del modello in uso.

Backup Recupera i modelli e altri dati memorizzati nella stampante e li
salva sul computer.
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Icona Nome pulsante Funzione

Apri Apre il modello selezionato.

Cerca Esegue la ricerca di modelli e altri dati memorizzati in P-touch
Library.

Stile visualizzazione Modifica lo stile di visualizzazione del file.

  Informazioni correlate

• Trasferimento di modelli dal computer alla stampante (Windows) 
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Trasferire modelli o altri dati dal computer alla stampante (Windows)
È possibile trasferire modelli, database e immagini dal computer alla stampante.

Per trasferire i modelli da un dispositivo mobile alla stampante, uu Informazioni correlate

1. Collegare la stampante e il computer con un cavo USB, quindi accendere la stampante.
Il nome del modello della stampante viene visualizzato accanto all'icona della stampante nella
visualizzazione cartella.
Se si seleziona una stampante nella visualizzazione cartella, vengono visualizzati i modelli correnti e altri dati
memorizzati nella stampante.

Se una stampante è scollegata o offline, non viene elencata nella visualizzazione cartella.

2. Selezionare la stampante alla quale si desidera trasferire il modello o altri dati.

3. Fare clic con il pulsante destro del mouse sulla cartella Configurazioni, selezionare Nuova, quindi creare
una nuova cartella.
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4. Effettuare una delle seguenti operazioni:
• Trascinare il modello o gli altri dati da trasferire nella nuova cartella.
• Per trasferire più modelli o altri dati, trascinare i file desiderati nella nuova cartella. Al momento del

trasferimento della nuova cartella, a ogni file viene assegnato un numero chiave (posizione nella memoria
della stampante).

Tipo dati Numero massimo di
elementi trasferibili

Dettagli limitazione

Modello 255 Ciascun modello può contenere al massimo 255 oggetti.

Database 255 • Possono essere trasferiti solo i file CSV.
• Ciascun file CSV può contenere al massimo 65.000

record.

Immagine (simboli
trasferiti)

255 • È possibile trasferire solo file BMP.
• Si consigliano i file BMP monocromatici.
• La dimensione massima è 2560 x 2560 pixel.
• Le immagini molto grandi possono essere ritagliate.

53



• È possibile verificare lo spazio disponibile nella memoria dei file di trasferimento stampando il report
sulle impostazioni della stampante. Per verificare quanto spazio è disponibile, consultare Available
memory (Memoria disponibile) nel report. Lo spazio disponibile visualizzato in Available memory:
****B (Memoria disponibile: ****B) potrebbe essere diverso dall'effettivo spazio disponibile.

• È possibile visualizzare i modelli e altri dati selezionando:
- La cartella nella cartella Configurazioni
- Tutti i file
- Una delle categorie in Filtro, come ad esempio Layout

5. Per modificare il numero di chiave assegnato a un determinato elemento, fare clic con il pulsante destro del
mouse sull'elemento, selezionare il menu Codice assegnato, quindi selezionare il numero chiave
desiderato.

• Tranne per i dati dei database, a tutti i dati trasferiti alla stampante viene assegnato un numero chiave.
• Se al modello o agli altri dati trasferiti alla stampante viene assegnato un numero chiave già associato a

un altro modello precedentemente salvato nella stampante, il vecchio modello viene sovrascritto da
quello nuovo. È possibile verificare i numeri chiave assegnati e salvati nella stampante eseguendo il
backup dei modelli e degli altri dati.

• Se la memoria della stampante è piena, rimuovere uno o più modelli dalla memoria della stampante.

6. Per modificare i nomi dei modelli o altri dati da trasferire, fare clic sull'elemento desiderato e digitare un
nuovo nome.
Il numero di caratteri utilizzabili per i nomi dei modelli potrebbe essere soggetto a dei limiti in base al modello
della stampante.

7. Selezionare la cartella contenente i modelli o gli altri dati da trasferire, quindi fare clic su Trasferisci.
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Viene visualizzato un messaggio di conferma.

• È possibile inoltre trasferire singoli elementi alla stampante senza aggiungerli ad alcuna cartella.
Selezionare il modello o altri dati da trasferire, quindi fare clic su Trasferisci.

• È possibile selezionare più elementi o più cartelle e trasferirli mediante una sola operazione.

8. Fare clic su OK.
Gli elementi selezionati vengono trasferiti alla stampante.

  Informazioni correlate

• Trasferimento di modelli dal computer alla stampante (Windows) 
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Backup dei modelli o di altri dati memorizzati nella stampante
(Windows)

È possibile recuperare i modelli o altri dati memorizzati nella stampante e salvarli sul computer.

• I modelli e i dati di backup non possono essere modificati nel computer.
• A seconda del modello di stampante, potrebbe non essere possibile trasferire i modelli o i dati salvati a

un modello differente.

1. Collegare il computer e la stampante e accendere la stampante.
Il nome del modello della stampante viene visualizzato accanto all'icona della stampante nella
visualizzazione cartella. Se si seleziona una stampante nella visualizzazione cartella, vengono visualizzati i
modelli correnti e altri dati memorizzati nella stampante.

2. Selezionare la stampante da cui eseguire il backup, quindi fare clic su Backup.

Viene visualizzato un messaggio di conferma.
3. Fare clic su OK.

Nella visualizzazione cartella viene creata una nuova cartella per la stampante. Il nome di tale cartella è
composto dalla data e dall'ora del backup. Tutti i modelli della stampante e gli altri dati vengono trasferiti nella
nuova cartella e salvati sul computer.

  Informazioni correlate

• Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows) 
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Eliminazione di dati dalla stampante (Windows)
È possibile eliminare tutti i modelli o gli altri dati memorizzati sulla stampante.
1. Collegare il computer e la stampante e accendere la stampante.

Il nome del modello della stampante viene visualizzato accanto all'icona della stampante nella
visualizzazione cartella.

2. Fare clic con il pulsante destro del mouse sulla stampante e selezionare il menu Elimina tutto.

Viene visualizzato un messaggio di conferma.

3. Fare clic su OK.
Tutti i modelli e i dati memorizzati sulla stampante vengono eliminati.

  Informazioni correlate

• Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows) 

57



 Pagina Iniziale > Trasferimento dei modelli alla stampante (P-touch Transfer Manager)
(Windows) > Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager
(Windows) > Creazione di file di trasferimento e di file pacchetto di trasferimento (Windows)

Creazione di file di trasferimento e di file pacchetto di trasferimento
(Windows)

Utilizzare P-touch Transfer Manager per salvare i dati del modello creati utilizzando P-touch Editor nel formato
BLF o PDZ, quindi trasferire i file in questo formato a una stampante su una rete, da un computer o dispositivo
mobile.
È anche possibile stampare i file in formato BLF utilizzando la modalità di archiviazione di massa.

Metodo di trasferimento dei modelli Formato del file

Da un computer P-touch Transfer Express PDZ

Archiviazione di massa BLF

1. Creare il modello utilizzando P-touch Editor, quindi trasferirlo in P-touch Transfer Manager.

• Per ulteriori informazioni uu Informazioni correlate
• Quando si trasferisce un nuovo modello, specificare un numero Codice assegnato (in P-touch Transfer

Manager) non ancora utilizzato. Se il numero Codice assegnato è già in uso, il modello esistente verrà
sovrascritto dal nuovo modello.

2. Senza collegare la stampante al computer, selezionare la cartella Configurazioni nella finestra P-touch
Transfer Manager, quindi selezionare il modello da salvare.

È possibile selezionare modelli contemporaneamente.

3. Fare clic su File > Salva file di trasferimento.
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NOTA
Il pulsante Salva file di trasferimento viene visualizzato quando la stampante è scollegata dal computer
o è offline.

• Se si fa clic sul pulsante Salva file di trasferimento dopo avere selezionato Configurazioni, tutti i
modelli della cartella vengono salvati come file Transfer (BLF) o come file Transfer Package (PDZ).

• È possibile unire modelli diversi in un unico file Transfer (BLF) o file Transfer Package (PDZ).

4. Nel campo Salva come, selezionare il formato di modello desiderato, quindi digitare il nome e salvare il
modello.

  Informazioni correlate

• Trasferimento dei modelli alla stampante mediante P-touch Transfer Manager (Windows)

Argomenti correlati:
• Trasferimento del modello a P-touch Transfer Manager (Windows) 
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Distribuire i modelli da trasferire agli utenti senza P-touch Transfer
Manager (Windows)

È possibile trasferire i modelli alla stampante utilizzando P-touch Transfer Express. Come prima cosa,
l'amministratore crea un modello, poi lo distribuisce insieme a P-touch Transfer Express. È quindi possibile usare
P-touch Transfer Express per trasferire il modello direttamente alla stampante in dotazione.
Per scaricare l'ultima versione di P-touch Transfer Express, accedere alla pagina del modello Download sul sito
Web di supporto Brother all'indirizzo support.brother.com.

• Quando si trasferisce un nuovo modello, specificare un numero Codice assegnato (in P-touch Transfer
Manager) non ancora utilizzato. Se il numero Codice assegnato è già in uso, il modello esistente verrà
sovrascritto dal nuovo modello.

• Questa funzione richiede una connessione USB.

Amministratore Utenti

1.

2. 3. 4. 5.

>> Operazioni dell'amministratore
>> Operazioni dell'utente

Operazioni dell'amministratore

>> Preparazione di P-touch Transfer Express
>> Trasferire il modello a P-touch Transfer Manager
>> Salvare il modello come file pacchetto di trasferimento (PDZ)
>> Distribuire ad altri il file pacchetto di trasferimento (PDZ) e P-touch Transfer Express

Preparazione di P-touch Transfer Express

Prima di utilizzare P-touch Transfer Express è necessario installare il driver stampante.

P-touch Transfer Express è disponibile solo in lingua inglese.

1. Scaricare P-touch Transfer Express in qualsiasi percorso sul computer.
2. Decomprimere il file scaricato (ZIP).

Trasferire il modello a P-touch Transfer Manager

1. Avviare P-touch Editor .

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Editor 5.2 o doppio clic sull'icona P-touch Editor 5.2 sul
desktop.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
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Fare clic sull'icona P-touch Editor 5.2 nella schermata Applicazioni oppure fare doppio clic sull'icona P-
touch Editor 5.2 sul desktop.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Editor 5.2 o
doppio clic sull'icona P-touch Editor 5.2 sul desktop.

Si avvia P-touch Editor.
2. Aprire il modello desiderato.
3. Fare clic su File > Trasferisci modello > Trasferisci.

Il modello viene trasferito in P-touch Transfer Manager. Viene avviato P-touch Transfer Manager.

Salvare il modello come file pacchetto di trasferimento (PDZ)

Per creare un file in un formato utilizzabile da P-touch Transfer Express, salvare il modello come file pacchetto di
trasferimento (PDZ).
1. Selezionare la cartella Configurazioni nella finestra P-touch Transfer Manager.
2. Selezionare i modelli da distribuire.
3. Fare clic su File > Salva file di trasferimento.

• L'opzione Salva file di trasferimento viene visualizzata solo se la stampante è scollegata dal computer
o è offline.

• Se si fa clic sull'opzione Salva file di trasferimento dopo aver selezionato la cartella Configurazioni o
una cartella creata, tutti i modelli della cartella vengono salvati come file pacchetto di trasferimento
(PDZ).

• È possibile riunire più modelli in un unico file pacchetto di trasferimento (PDZ).

4. Digitare il nome, quindi fare clic su Salva.
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Il modello viene salvato come file pacchetto di trasferimento (PDZ).

Distribuire ad altri il file pacchetto di trasferimento (PDZ) e P-touch Transfer
Express

Se l'utente ha già scaricato P-touch Transfer Express, non è necessario che l'amministratore invii la cartella
Transfer Express. In tal caso, l'utente può semplicemente spostare il file pacchetto di trasferimento
distribuito nella cartella scaricata e fare quindi doppio clic su PtTrExp.exe.

1. Spostare il file pacchetto di trasferimento (PDZ) nella cartella dei download.

2. Distribuire ad altri tutti i file presenti nella cartella dei download.
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Operazioni dell'utente

Trasferire il file pacchetto di trasferimento (PDZ) alla stampante

Usando il software P-touch Transfer Express ricevuto dall'amministratore, l'utente può trasferire il file pacchetto
di trasferimento (PDZ) alla stampante.

Non spegnere l'apparecchio durante il trasferimento dei modelli.

1. Accendere la stampante.
2. Usando un cavo USB, collegare la stampante al computer.
3. Fare doppio clic sul file PtTrExp.exe ricevuto dall'amministratore.
4. Effettuare una delle seguenti operazioni:

• Per trasferire un unico file Transfer Package (PDZ) all'interno della cartella contenente il file PtTrExp.exe,
fare clic su Transfer.

• Per trasferire più di un file Transfer Package (PDZ) all'interno della cartella contenente il file PtTrExp.exe,
seguire le istruzioni:
a. Fare clic su Browse.

b. Selezionare il file pacchetto di trasferimento da trasferire, quindi fare clic su Apri.
c. Fare clic su Transfer.
d. Fare clic su Yes.

5. Al termine, fare clic su OK.

  Informazioni correlate

• Trasferimento dei modelli alla stampante (P-touch Transfer Manager) (Windows) 
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 Pagina Iniziale > Memorizzazione o gestione dei modelli (P-touch Library)

Memorizzazione o gestione dei modelli (P-touch Library)

• Modifica dei modelli utilizzando P-touch Library (Windows)

• Stampa di modelli mediante P-touch Library (Windows)

• Ricerca di modelli mediante P-touch Library (Windows)
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P-touch Library (Windows)

Modifica dei modelli utilizzando P-touch Library (Windows)
1. Avviare P-touch Library.

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Library 2.3.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Library 2.3 sulla schermata Applicazioni.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Tools > P-touch
Library 2.3.

Viene visualizzata la finestra principale.

Panoramica delle icone della barra degli strumenti

Icona Nome pulsante Funzione

Apri Apre il modello selezionato.

Stampa Stampa il modello selezionato utilizzando la stampante.

Cerca Esegue la ricerca di modelli memorizzati in P-touch Library.

Stile visualizzazione Modifica lo stile di visualizzazione del file.

2. Selezionare il modello da aprire o modificare, quindi fare clic su Apri.
Viene avviato il programma associato al modello ed è possibile modificare il modello.

  Informazioni correlate

• Memorizzazione o gestione dei modelli (P-touch Library) 
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Stampa di modelli mediante P-touch Library (Windows)
1. Avviare P-touch Library.

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Library 2.3.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Library 2.3 sulla schermata Applicazioni.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Tools > P-touch
Library 2.3.

Viene visualizzata la finestra principale.

2. Selezionare il modello da stampare, quindi fare clic su Stampa.
La stampante collegata stampa il modello.

  Informazioni correlate

• Memorizzazione o gestione dei modelli (P-touch Library) 
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Ricerca di modelli mediante P-touch Library (Windows)
È possibile eseguire la ricerca di modelli registrati in P-touch Library.
1. Avviare P-touch Library.

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Library 2.3.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Library 2.3 sulla schermata Applicazioni.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Tools > P-touch
Library 2.3.

Viene visualizzata la finestra principale.

2. Fare clic su Cerca.
Viene visualizzata la finestra di dialogo Cerca.
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3. Specificare i parametri di ricerca.
I parametri di ricerca disponibili sono i seguenti:

Impostazioni Dettagli

Parametri multipli Determina il metodo di ricerca nel caso in cui vengano
specificate più condizioni. Se si seleziona E, vengono
cercati i file che soddisfano tutti i criteri. Se si seleziona
O, vengono cercati i file che soddisfano qualsiasi
criterio.

Nome Consente di cercare un modello in base al nome del
file.

Tipo Consente di cercare un modello in base al tipo di file.

Dimensioni Consente di cercare un modello in base alle dimensioni
del file.

Data Consente di cercare un modello in base alla data del
file.

4. Fare clic su Inizia ricerca.
Viene avviata la ricerca e vengono visualizzati i risultati della ricerca.

5. Chiudere la finestra di dialogo Cerca.
È possibile confermare i risultati della ricerca facendo clic su Risultati ricerca nella visualizzazione cartella.

È possibile registrare i modelli in P-touch Library trascinandoli e rilasciandoli nella cartella Tutti i file o
nell'elenco delle cartelle.

  Informazioni correlate

• Memorizzazione o gestione dei modelli (P-touch Library) 
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 Pagina Iniziale > Rete

Rete

Modelli correlati: TD-4420DN/TD-4520DN

• Informazioni sul software e sulle utilità per la gestione della rete

• Modifica delle impostazioni stampante mediante la Gestione basata sul Web
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Informazioni sul software e sulle utilità per la gestione della rete

Modelli correlati: TD-4420DN/TD-4520DN

Gestione basata sul Web
Gestione basata sul Web è un'utilità che impiega un browser Web standard per gestire l'apparecchio utilizzando
il protocollo HTTP (Hyper Text Transfer Protocol) oppure il protocollo HTTPS (Hyper Text Transfer Protocol over
Secure Socket Layer). Digitare nel browser Web l'indirizzo IP dell'apparecchio per accedere alle impostazioni del
server di stampa e modificarle.

BRAdmin Light (Windows)
BRAdmin Light è un'utilità che consente di eseguire l'impostazione iniziale delle stampanti Brother collegate in
rete. Questa utilità consente la ricerca delle stampanti Brother in rete, la visualizzazione del loro stato e la
configurazione delle impostazioni di rete di base, come l'indirizzo IP.
Per scaricare BRAdmin Light., accedere alla pagina Download del modello sul sito Web di supporto Brother
all'indirizzo support.brother.com.

Se si sta utilizzando un software firewall, anti-spyware o antivirus, disattivarlo temporaneamente. Riattivarlo
quando si è sicuri di poter stampare.

BRAdmin Professional (Windows)
BRAdmin Professional è un'utilità che consente una gestione più avanzata delle stampanti Brother connesse alla
rete. Questa utilità consente la ricerca delle stampanti Brother in rete e la visualizzazione del loro stato in una
schermata di facile uso, simile a Esplora risorse di Windows, in cui lo stato di ogni dispositivo è contrassegnato
da un colore diverso. È possibile configurare le impostazioni di rete e delle stampanti e aggiornare il relativo
firmware da un computer Windows collegato alla rete LAN. BRAdmin Professional è inoltre in grado di registrare
l'attività delle stampanti Brother sulla rete e di esportare i dati del registro.
Accedere alla pagina Download relativa al modello in uso nel sito Web di supporto Brother all'indirizzo
support.brother.com per scaricare l'ultima versione dell'utilità BRAdmin Professional di Brother.

• Il nome del nodo appare nella finestra corrente di BRAdmin Professional.
Il nome del nodo predefinito è "BRNxxxxxxxxxxxx". (il valore "xxxxxxxxxxxx" si basa su Indirizzo MAC/
Indirizzo Ethernet della stampante.)

• Se si sta utilizzando un software firewall, anti-spyware o antivirus, disattivarlo temporaneamente.
Riattivarlo quando si è sicuri di poter stampare.

  Informazioni correlate

• Rete 
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 Pagina Iniziale > Aggiorna

Aggiorna

• Aggiornamento di P-touch Editor (Windows)

• Aggiornamento del firmware
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 Pagina Iniziale > Aggiorna > Aggiornamento di P-touch Editor (Windows)

Aggiornamento di P-touch Editor (Windows)

Prima di aggiornare P-touch Editor, installare il driver stampante.

1. Avviare P-touch Update Software.
• Windows 10/Windows Server 2016:

Fare clic su Start > Brother P-touch > P-touch Update Software o doppio clic sull'icona P-touch
Update Software sul desktop.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Update Software nella schermata Applicazioni oppure fare doppio clic
sull'icona P-touch Update Software sul desktop.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Update Software
o doppio clic sull'icona P-touch Update Software sul desktop.

2. Fare clic sull'icona Aggiornamento software computer.

3. Selezionare le opzioni Stampante e Lingua, selezionare la casella di controllo posta accanto a P-touch
Editor, quindi fare clic su Installa.

Al termine, viene visualizzata una finestra di dialogo di conferma.
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  Informazioni correlate

• Aggiorna 
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 Pagina Iniziale > Aggiorna > Aggiornamento del firmware

Aggiornamento del firmware

• Prima di aggiornare il firmware, è necessario installare il driver stampante.
• Non spegnere la macchina durante il trasferimento dei dati o l'aggiornamento del firmware.
• Se è in esecuzione un'altra applicazione, uscire dall'applicazione stessa.

1. Accendere la stampante e collegare il cavo USB.
2. Avviare P-touch Update Software.

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother P-touch > P-touch Update Software o doppio clic sull'icona P-touch
Update Software sul desktop.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona P-touch Update Software nella schermata Applicazioni oppure fare doppio clic
sull'icona P-touch Update Software sul desktop.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother P-touch > P-touch Update Software
o doppio clic sull'icona P-touch Update Software sul desktop.

3. Fare clic sull'icona Aggiornamento dispositivo.

4. Selezionare l'opzione Stampante, controllare che la macchina sia collegata correttamente e fare clic su OK.

5. Selezionare l'opzione Lingua, selezionare la casella di controllo accanto al firmware da aggiornare, quindi
fare clic su Trasferisci.
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NOTA
Durante il trasferimento dei dati, non spegnere la stampante e non scollegare il cavo.

6. Controllare il contenuto da aggiornare, quindi fare clic su Avvia per avviare l'aggiornamento.
L'aggiornamento del firmware viene avviato.

NOTA
Durante il processo di aggiornamento, non spegnere la stampante e non scollegare il cavo.

  Informazioni correlate

• Aggiorna 
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 Pagina Iniziale > Impostazioni stampante

Impostazioni stampante

• Modifica delle impostazioni stampante tramite lo Strumento di impostazione della
stampante (Windows)

• Applicazione delle modifiche delle impostazioni a più stampanti (Windows)

• Modifica delle impostazioni stampante mediante la Gestione basata sul Web

• Conferma delle impostazioni della stampante
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 Pagina Iniziale > Impostazioni stampante > Modifica delle impostazioni stampante tramite lo Strumento di
impostazione della stampante (Windows)

Modifica delle impostazioni stampante tramite lo Strumento di
impostazione della stampante (Windows)

• Assicurarsi che l'adattatore CA sia collegato alla stampante e il cavo di alimentazione CA sia collegato a
una presa elettrica.

• Assicurarsi che il driver della stampante sia stato installato correttamente e che la stampa sia abilitata.
• Collegare la stampante a un computer tramite un cavo USB.

• Quando si utilizza il programma di installazione, lo Strumento di impostazione della stampante viene
installato in aggiunta al driver stampante e all'altro software.

• Printer Setting Tool (Strumento di impostazione della stampante) è disponibile solo per stampanti
Brother compatibili.

1. Collegare la stampante da configurare al computer.
2. Avviare lo Strumento di impostazione della stampante.

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother > Printer Setting Tool.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona Printer Setting Tool sulla schermata Applicazioni.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother > Label & Mobile Printer > Printer
Setting Tool.

Viene visualizzata la finestra principale.

3

2

4

5

6

1

1. Stampante
Elenca le stampanti collegate.

2. Impostazioni di comunicazione (TD-4420DN/TD-4520DN)
(TD-4420DN/TD-4520DN) Specifica le impostazioni di comunicazione LAN cablata.

3. Impostazioni dispositivo
Specifica le impostazioni del dispositivo. Ad esempio, le impostazioni dell'alimentazione.
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4. Impostazioni P-touch Template
Specifica le impostazioni P-touch Template.
Per ulteriori informazioni uu Manuale P-touch Template/ Comando di riferimento (Manuale per il modello
P-touch/Riferimento per i comandi, solo in inglese). È possibile scaricare l'ultima versione dal sito Web di
supporto Brother alla pagina support.brother.com/manuals.

5. Impostazione formato carta
Per utilizzare formati non presenti nell'elenco Formato carta del driver stampante, è necessario
aggiungere al driver stampante i dati e le impostazioni sul supporto di stampa.

NOTA
Per aprire Impostazione formato carta, è necessario aver eseguito l'accesso con i diritti di
amministratore.

6. Esci
Chiude la finestra.

3. Controllare che la stampante da configurare sia riportata accanto a Stampante.
Se viene visualizzata una stampante diversa, selezionare la stampante desiderata dall'elenco a discesa.

4. Consente di selezionare le impostazioni da modificare e specificare o modificare le impostazioni nella finestra
di dialogo.

5. Fare clic su Applica per applicare le impostazioni della stampante.
6. Per completare la modifica delle impostazioni nella finestra principale, fare clic su Esci.

Lo Strumento di impostazione della stampante deve essere utilizzato per configurare la stampante solo
quando questa è in fase di standby. Se si tenta di eseguire la configurazione mentre è in corso la stampa di
un lavoro, la stampante potrebbe non funzionare correttamente.

  Informazioni correlate

• Impostazioni stampante

• Impostazioni di comunicazione dello Strumento di impostazione della stampante (Windows)
• Impostazioni dispositivo dello Strumento di impostazione della stampante (Windows)
• Impostazioni P-touch Template dello Strumento di impostazione della stampante (Windows)
• Impostazione del formato carta dello Strumento di impostazione della stampante (Windows) 
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 Pagina Iniziale > Impostazioni stampante > Modifica delle impostazioni stampante tramite lo Strumento di
impostazione della stampante (Windows) > Impostazioni di comunicazione dello Strumento di impostazione
della stampante (Windows)

Impostazioni di comunicazione dello Strumento di impostazione della
stampante (Windows)

Modelli correlati: TD-4420DN/TD-4520DN

Le Impostazioni di comunicazione dello Strumento di impostazione della stampante consentono di specificare o
modificare le informazioni di comunicazione della stampante quando si collega la stampante a un computer con
un cavo USB. Oltre a modificare le impostazioni di comunicazione per una stampante, è possibile anche
applicare le stesse impostazioni a più stampanti.
>>  Finestra di dialogo delle impostazioni
>>  Barra dei menu
>>  Scheda Generale
>>  Scheda LAN cablata

Finestra di dialogo delle impostazioni

1

2
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1. Barra dei menu
Consente di accedere ai diversi comandi, suddivisi per titolo del menu (menu File, Strumenti e Guida) in
base alle rispettive funzioni.

2. Nome nodo
Visualizza il nome del nodo (i nodi possono essere rinominati).

3. Area di visualizzazione/modifica delle impostazioni
Visualizza le impostazioni correnti relative all'elemento selezionato.

4. Aggiorna
Aggiorna le impostazioni visualizzate con le informazioni più recenti.

5. Esci
Esce dalla finestra Impostazioni di comunicazione e torna alla finestra principale dello Strumento di
impostazione della stampante.

Dopo aver modificato le impostazioni, queste vengono applicate alle stampanti solo se si fa clic sul
pulsante Esci e anche sul pulsante Applica.
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6. Applica
Applica le impostazioni alla stampante. Per salvare le impostazioni specificate in un file dei comandi,
selezionare il comando Salva nel file di comando dall'elenco a discesa. Il file di comando salvato può
essere usato con la modalità di archiviazione di massa per applicare le impostazioni a una stampante.

Facendo clic su Applica, tutte le impostazioni di tutte le schede vengono applicate alla stampante. Se è
selezionata la casella di controllo Disattiva queste impostazioni, le impostazioni non vengono applicate.

7. Elementi
Se si seleziona il menu Stato corrente, nell'area di visualizzazione/modifica delle impostazioni vengono
visualizzate le impostazioni correnti. Selezionare l'elemento di cui si desidera modificare le impostazioni.

8. Disattiva queste impostazioni

Selezionando questa casella di controllo, nella scheda compare l'icona  e le impostazioni non possono

essere più né specificate né modificate. Le impostazioni di una scheda in cui è presente l'icona  non
saranno applicate alla stampante, nemmeno facendo clic su Applica. Inoltre, quando si utilizza il comando
Salva nel file di comando o Esporta, le impostazioni specificate nella scheda non verranno salvate né
esportate. Per applicare le impostazioni alla stampante o per salvarle ed esportarle, deselezionare la casella
di controllo.

9. Schede delle impostazioni
Contengono impostazioni che possono essere specificate o modificate. Se nella scheda viene visualizzata
l'icona , le impostazioni non saranno applicate alla stampante.

10. Stampante
Elenca le stampanti collegate.

Barra dei menu

Opzioni di menu File
• Applica impostazione alla stampante

Applica le impostazioni alla stampante.
• Salva impostazioni nel file di comando

Salva le impostazioni specificate in un file di comando. L'estensione del file è BIN. Il file di comando salvato
può essere usato con la modalità di archiviazione di massa per applicare le impostazioni a una stampante.

- Se è selezionata la casella di controllo Disattiva queste impostazioni, le impostazioni non vengono
salvate.

- Le informazioni seguenti non vengono salvate con il file di comando.
• Nome nodo
• Indirizzo IP, maschera di sottorete e gateway predefinito (quando l'indirizzo IP è impostato su

STATIC)
- I comandi delle impostazioni di comunicazione salvate vanno usati solo per applicare le impostazioni a

una stampante. Per applicare le impostazioni alla stampante usando questo file di comando, servirsi
della modalità di archiviazione di massa.

- I file di comando salvati contengono le chiavi di autenticazione e le password. Adottare le misure
necessarie per proteggere i file di comando salvati, ad esempio salvandoli in un percorso non
accessibile da altri utenti.

- Non inviare i file di comando a un modello di stampante diverso.

• Certificati di installazione
Alcuni metodi di autenticazione di rete potrebbero richiedere un certificato.
Installare un certificato sulla stampante collegata oppure salvare un certificato come file di comando da
distribuire alle stampanti dello stesso modello.

• Importa
- Selezionare un profilo da importare
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Importa il file esportato e applica le impostazioni a una stampante. Fare clic su Sfoglia e selezionare il file
da importare. Le impostazioni del file selezionato sono visualizzate nell'area di visualizzazione/modifica
delle impostazioni.

• È possibile importare tutte le impostazioni, fatta eccezione per i nomi dei nodi.
• È possibile importare solo i profili compatibili con la stampante selezionata.
• Se l'indirizzo IP del profilo importato è impostato su STATIC, modificare l'indirizzo IP del profilo

importato, se necessario, in modo tale che non duplichi l'indirizzo IP di una stampante configurata
esistente sulla rete.

• Esporta
Salva in un file le impostazioni correnti. Se è selezionata la casella di controllo Disattiva queste
impostazioni, le impostazioni non vengono salvate.

I file esportati non vengono crittografati.

Opzioni di menu Strumenti
• Impostazioni opzioni

- Riavvia automaticamente la stampante dopo aver applicato le nuove impostazioni
Se questa casella di controllo è selezionata, la stampante si riavvia automaticamente dopo che sono
state applicate le impostazioni di comunicazione. Se questa casella di controllo è deselezionata, è
necessario riavviare manualmente la stampante.

Quando si configurano più stampanti, è possibile ridurre il tempo necessario a modificare le impostazioni
deselezionando questa casella di controllo. In questo caso, è consigliabile selezionare questa casella di
controllo quando si configura la prima stampante, in modo da poter verificare che ciascuna impostazione
stia funzionando correttamente.

- Rileva automaticamente la stampante collegata e recupera le impostazioni correnti
Se questa casella di controllo è selezionata e una stampante è collegata al computer, la stampante viene
rilevata automaticamente e le impostazioni correnti della stampante vengono visualizzate nel riquadro
Stato corrente.

Se la stampante collegata è diversa da quella visualizzata nell'elenco a discesa Stampante, le
impostazioni disponibili in tutte le schede cambiano per corrispondere a quelle della stampante collegata.

• Cambia nome nodo/nome dispositivo Bluetooth
Consente di rinominare un nodo.

• Ripristina impostazioni di comunicazione predefinite
Ripristina le impostazioni di comunicazione sulle impostazioni di fabbrica.

Opzioni di menu Guida
• Visualizza la Guida

Consente di visualizzare gli argomenti della Guida.

Scheda Generale

IPv6
• Uso IPv6

Seleziona Attivare o Disattivare.
• Priorità sull'indirizzo IPv6

Assegna la priorità a un indirizzo IPv6.

Scheda LAN cablata

TCP/IP
• Metodo di avvio
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Seleziona l'opzione AUTO, BOOTP, DHCP, RARP o STATIC.
• Indirizzo IP/Maschera di sottorete/Gateway

Specifica i vari valori di connessione rete. È possibile immettere queste impostazioni solo quando
l'indirizzo IP è impostato su STATIC.

• Metodo server DNS
Seleziona l'opzione AUTO o STATIC.

• Indirizzo IP server DNS primario/Indirizzo IP server DNS secondario
È possibile immettere queste impostazioni solo quando il server DNS è impostato su STATIC.

IPv6
• Indirizzo IPv6 statico

Specifica un indirizzo IPv6 permanente.
• Attiva questo indirizzo

Attiva l'indirizzo IPv6 statico specificato.
• Indirizzo IPv6 Server DNS Primario/Indirizzo IPv6 Server DNS Secondario

Specifica gli indirizzi IPv6 server DNS.
• Elenco indirizzi IPv6

Visualizza l'elenco di indirizzi IPv6.

autenticazione 802.1x
Configura l'autenticazione IEEE 802.1x.
• Stato 802.1x cablato

Abilitare o disabilitare l'autenticazione IEEE 802.1x per la rete cablata.
• Metodo di autenticazione

Selezionare il metodo di autenticazione.
• ID utente/Password

È possibile specificare le impostazioni solo se il metodo di autenticazione selezionato è EAP-MD5, EAP-
FAST, PEAP, EAP-TTLS o EAP-TLS. Inoltre, con EAP-TLS, non è necessario registrare una password, ma
deve essere registrato un certificato client. Per registrare un certificato, collegarsi alla stampante da un
browser Web, quindi specificare il certificato. L'installazione del certificato di autenticazione può essere
effettuata anche utilizzando lo Strumento di impostazione della stampante accedendo alla barra dei menu:
File > Certificati di installazione.

  Informazioni correlate

• Modifica delle impostazioni stampante tramite lo Strumento di impostazione della stampante (Windows) 
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 Pagina Iniziale > Impostazioni stampante > Modifica delle impostazioni stampante tramite lo Strumento di
impostazione della stampante (Windows) >  Impostazioni dispositivo dello Strumento di impostazione della
stampante (Windows)

Impostazioni dispositivo dello Strumento di impostazione della
stampante (Windows)

Usare Impostazioni dispositivo nello Strumento di impostazione della stampante per specificare o modificare le
impostazioni della stampante quando si collegano la stampante e il computer con un cavo USB. È possibile non
solo modificare le impostazioni dispositivo per una stampante, ma anche applicare facilmente le stesse
impostazioni a più stampanti. Quando si stampa da un'applicazione, è possibile specificare diverse impostazioni
di stampa dal driver della stampante; tuttavia, se si utilizza lo strumento Impostazioni dispositivo nello Strumento
di impostazione della stampante, è possibile specificare altre impostazioni avanzate. Quando si apre la finestra
Impostazioni dispositivo, vengono recuperate e visualizzate le impostazioni correnti della stampante. Se non è
stato possibile recuperare le impostazioni correnti, vengono visualizzate le impostazioni precedenti. Se non è
stato possibile recuperare le impostazioni correnti e le impostazioni precedenti non sono state specificate,
vengono visualizzate le impostazioni predefinite della macchina.
>> Finestra di dialogo delle impostazioni
>>  Barra dei menu
>> Scheda Base
>> Scheda Avanzate
>> Scheda Posizione di stampa/sensori
>> Scheda Imp. gestione

Finestra di dialogo delle impostazioni
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1. Barra dei menu
Consente di accedere ai diversi comandi, suddivisi per titolo del menu (menu File, Manutenzione e
Informazioni su(_G)...) in base alle rispettive funzioni.

2. Impostazioni correnti
Recupera le impostazioni dalla stampante collegata correntemente e le visualizza nella finestra di dialogo. Le
impostazioni possono essere recuperate anche per i parametri sulle schede che presentano l'icona .

3. Disattiva queste impostazioni

Se si seleziona questa casella di controllo, nella scheda compare l'icona  e le impostazioni non possono

essere più né specificate né modificate. Le impostazioni di una scheda in cui è presente l'icona  non
saranno applicate alla stampante, nemmeno facendo clic su Applica. Inoltre, quando si utilizza il comando
Salva nel file di comando o Esporta, le impostazioni nella scheda non verranno salvate né esportate.
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4. Parametri
Visualizza le impostazioni correnti.

5. Esci
Esce dalla finestra Impostazioni dispositivo e torna alla finestra principale dello Strumento di impostazione
della stampante.

6. Applica
Applica le impostazioni alla stampante. Per salvare le impostazioni specificate in un file dei comandi,
selezionare il comando Salva nel file di comando dall'elenco a discesa.
Il file di comando salvato può essere usato con la modalità di archiviazione di massa per applicare le
impostazioni a una stampante.

7. Schede delle impostazioni
Contengono impostazioni che possono essere specificate o modificate.

Se nella scheda è presente l'icona , le impostazioni non possono essere modificate. Inoltre, le
impostazioni della scheda non saranno applicate alla stampante anche se si fa clic su Applica. Quando si
utilizza il comando Salva nel file di comando o Esporta, le impostazioni nella scheda non verranno
salvate né esportate.

8. Stamp
Specifica la stampante da configurare.

Barra dei menu

Opzioni di menu File
• Applica impostazione alla stampante

Applica le impostazioni alla stampante.
• Verifica impostazione

Visualizza le impostazioni correnti.
• Salva impostazioni nel file di comando

Salva le impostazioni specificate in un file di comando.
• Importa

Importa il file esportato.
• Esporta

Salva in un file le impostazioni correnti.
• Esci

Esce dalla finestra Impostazioni dispositivo e torna alla finestra principale dello Strumento di impostazione
della stampante.

Opzioni di menu Manutenzione

Per visualizzare alcuni elementi, è necessario disporre dei privilegi di amministratore per il computer o la
stampante. Verificare i privilegi di amministratore per la stampante facendo clic sul menu Proprietà
stampante e poi sulla scheda Sicurezza.

• Salva registro di stampa nel file
Salva il registro di stampa in un file nel formato CSV.

• Impostazioni unità di stampa
Stampa un rapporto che contiene la versione del firmware corrente e informazioni sulle impostazioni del
dispositivo.

Per stampare il rapporto, è consigliabile usare un rotolo RD da 62 mm o più grande.

• Controlla stato testine di stampa
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Controlla la presenza di eventuali problemi con la testina di stampa.
• Ripristina sulle impostazioni di fabbrica

(TD-4410D) Consente di ripristinare sui valori di fabbrica tutte le impostazioni, incluse quelle del dispositivo e
i dati trasferiti.
(TD-4420DN/TD-4520DN) Consente di ripristinare sui valori di fabbrica tutte le impostazioni, incluse quelle
del dispositivo, i dati trasferiti e le impostazioni di rete.

• Impostazioni ripristino del solo dispositivo
Reimposta i valori di fabbrica per le impostazioni che possono essere modificate mediante Impostazioni
dispositivo.

• Elimina modello e database
Elimina i modelli e i database memorizzati nella stampante.

• Elimina registro di stampa
Elimina il registro di stampa memorizzato nella stampante.

• Impostazioni opzioni
Se la casella di controllo Non visualizzare un messaggio di errore se le impostazioni correnti non
possono essere recuperate all'avvio è selezionata, la volta successiva non verrà visualizzato un
messaggio.

Scheda Base

• Accensione automatica
Specifica se la stampante si accende automaticamente quando il cavo di alimentazione CA viene collegato a
una presa elettrica.

• Sospensione automatica
Indica il tempo che deve trascorrere prima che la stampante entri automaticamente in modalità riposo.

- La stampante passa automaticamente in modalità riposo una volta trascorso il tempo specificato nelle
seguenti condizioni:
• La stampante non riceve i dati.
• Un cavo LAN non è collegato. (TD-4420DN/TD-4520DN)
• In modalità standby.
• Quando la comunicazione non avviene mediante la porta seriale.

- La modalità riposo viene annullata quando vengono eseguite le seguenti operazioni:
• Si preme un qualsiasi pulsante della stampante.
• Il coperchio del vano del rotolo è aperto o chiuso.
• La stampante riceve i dati. (esclusione mediante porta seriale)
• Un cavo USB viene scollegato e poi ricollegato.

• Spegnimento automatico
Specifica quanto tempo trascorre prima che la stampante si spenga automaticamente quando è collegata a
una presa elettrica.
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- La stampante passa automaticamente in modalità di spegnimento una volta trascorso il tempo
specificato nelle seguenti condizioni:
• La stampante non riceve i dati.
• Un cavo LAN non è collegato. (TD-4420DN/TD-4520DN)
• In modalità standby.
• Quando la comunicazione non avviene mediante la porta seriale.

- La modalità di spegnimento si annulla quando vengono eseguite le seguenti operazioni:
• Si preme un qualsiasi pulsante della stampante.
• Il coperchio del vano del rotolo è aperto o chiuso.
• La stampante riceve i dati. (esclusione mediante porta seriale)
• Un cavo USB viene scollegato e poi ricollegato.

• Direz. testo
Permette di selezionare l'orientamento di stampa.

• Velocità di stampa
Permette di selezionare la velocità di stampa della stampante.

• Densità di stampa
Consente di regolare la densità di stampa della stampante.

• Allinea il bordo iniziale del foglio quando il coperchio è chiuso
Consente di specificare se la carta viene fatta avanzare automaticamente quando il coperchio è chiuso.

• Posiz. uscita
Consente di selezionare la posizione di uscita del supporto di stampa.

• Taglio Autom.
Imposta il metodo di taglio quando si stampano più etichette.

• Configurazione automatica velocità
Regola automaticamente la velocità di stampa e stampa con la densità di stampa migliore.

Scheda Avanzate

• Funzione tasto Alimentazione

Consente di selezionare l'operazione eseguita quando viene premuto il pulsante . Se si seleziona
l'opzione Impostazioni programma, fare clic su File e selezionare il file di comando.

• Funzione tasto funzione

Consente di selezionare l'operazione eseguita quando viene premuto il pulsante . Se si seleziona
l'opzione Impostazioni programma, fare clic su File e selezionare il file di comando.
Se viene applicata la taglierina, è possibile impostare il taglio manuale con il tasto funzione.

• Stampa rapporto informazioni
Consente di selezionare le informazioni da includere nel Rapporto informazioni stampante.

• Impostazione stampa JPEG
Seleziona il metodo di elaborazione delle immagini quando si stampano immagini JPEG.

• Mod. serial.
Per mette di specificare il metodo di serializzazione (numero) per le etichette della stampante.

• Salva registro di stampa stampante
Consente di salvare o meno il registro di stampa della stampante. Se si seleziona l'opzione Disattivare, non
è possibile abilitare l'opzione Salva registro di stampa nel file.

• Stampa dati dopo aver stampato
Specifica se i dati di stampa vengono cancellati dopo la stampa.
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Scheda Posizione di stampa/sensori

Se i rotoli RD sono in uso, non è necessario regolare i sensori.
• Regolaz. punto riferim. stampa

Consente di regolare la posizione del punto di riferimento (punto di origine per la stampa). Corregge gli errori
di allineamento della stampa derivanti dalle differenze nei modelli di stampante o dai margini fissi di alcuni
software.
Per la stampa raster (griglia) non è possibile modificare il punto di riferimento.

• Regola strappo
Consente di regolare la posizione di strappo della barra di strappo per il supporto carta.

• Sensore multimediale (trasmissivo/spazio)
- Sensibilità rilevamento

Consente di regolare la sensibilità di rilevazione dello spazio (spaziatura) per le etichette pretagliate.
- Regolazione luminescenza

Consente di regolare la quantità di luce emessa dal sensore trasmissivo/spazio.
• Sensore multimediale (riflettente/barra)

- Sensibilità rilevamento macchia
Consente di regolare la sensibilità di rilevazione del segno nero.

- Regolazione luminescenza
Consente di regolare la quantità di luce emessa dal sensore riflettente/segno nero.

• Sensore supporto (sfogliatrice)
Specifica le impostazioni quando viene usata la sfogliatrice (opzionale).
- Sensibilità rilevamento

Consente di regolare la precisione del sensore che rileva se l'etichetta è stata sfogliata.

Scheda Imp. gestione

Per visualizzare questa scheda, è necessario disporre dei privilegi di amministratore per il computer o la
stampante. Verificare i privilegi di amministratore per la stampante facendo clic sul menu Proprietà
stampante e poi sulla scheda Sicurezza.

• Modalità di comando
Consente di selezionare il tipo di modalità comando.

• Controllo testine di stampa quando accesa
Consente di impostare l'eventuale controllo dello stato della testina di stampa all'accensione della stampante.

  Informazioni correlate

• Modifica delle impostazioni stampante tramite lo Strumento di impostazione della stampante (Windows) 
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Impostazioni P-touch Template dello Strumento di impostazione della
stampante (Windows)

La modalità P-touch Template consente di inserire dati in oggetti testo e codice a barre da un modello scaricato
mediante altri dispositivi collegati alla stampante. Le opzioni e le forniture disponibili possono variare a seconda
del paese. Per specificare o modificare le funzioni di P-touch Template, usare le impostazioni P-touch Template
nello Strumento di impostazione della stampante.

• La modalità P-touch Template è compatibile anche con altri dispositivi di ingresso quali bilance,
macchine per test, controller o dispositivi a logica programmabile.

• Per ulteriori informazioni sulle impostazioni di P-touch Template uu Manuale P-touch Template/
Comando di riferimento (Manuale per il modello P-touch/Riferimento per i comandi, solo in inglese). È
possibile scaricare l'ultima versione dal sito Web di supporto Brother alla pagina support.brother.com/
manuals.

1

2

3

5
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4

6
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8
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12

15

10

17

13

1. Default Command Mode (Modalità di comando predefinita)
Imposta la modalità P-touch Template come modalità predefinita. Per modificare la modalità, accedere alla
scheda Imp. gestione sulla finestra Impostazioni dispositivo e selezionare la modalità desiderata.

2. Default Template Number (Numero di modello predefinito)
Specifica un numero di modello predefinito impostato dalla stampante quando viene accesa. Tuttavia, se non
si trasferisce alcun modello alla stampante, non specificare un numero di modello.

3. Data Delimiter for P-touch Template (Delimitatore di dati per P-touch Template)
Visualizza un simbolo utilizzato per indicare i limiti tra gruppi di dati in un file (massimo 20 caratteri).

4. Trigger for P-touch Template Printing (Trigger per la stampa di P-touch Template)
Consente di specificare un trigger per l'avvio della stampa da una serie di opzioni.
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• Command Character (Carattere di comando): la stampa ha inizio quando viene ricevuto il carattere di
comando specificato qui.

• Data Insertion into All the Objects (Inserimento dati in tutti gli oggetti): la stampa ha inizio quando
viene ricevuto il delimitatore per l'ultimo oggetto.

• Received Data Size (Dimensioni dei dati ricevuti): la stampa ha inizio quando viene ricevuto il numero
di caratteri specificato qui. Tuttavia, i delimitatori non vengono contati nel numero di caratteri.

5. Character Code Table (Tabella codici carattere)
Consente di selezionare uno dei seguenti set di codici di caratteri.

6. International Character Set (Set di caratteri internazionale)
Elenca i set di caratteri per paesi specifici. I seguenti codici variano a seconda del paese selezionato:

23h 24h 40h 5Bh 5Ch 5Dh 5Eh 60h 7Bh 7Ch 7Dh 7Eh
Per modificare i caratteri uu Manuale P-touch Template/ Comando di riferimento (Manuale per il modello
P-touch/Riferimento per i comandi, solo in inglese). È possibile scaricare l'ultima versione dal sito Web di
supporto Brother alla pagina support.brother.com/manuals.

7. Command Prefix Character (Carattere prefisso comando)
Specifica il codice carattere del prefisso che identifica i comandi utilizzati in modalità P-touch Template.

8. Non-Printed Character (Carattere non stampato)
I caratteri specificati qui non vengono stampati al momento della ricezione dei dati (massimo 20 caratteri).

9. Available Return Code (Codice di rientro disponibile)
Il codice avanzamento riga è utilizzato durante l'inserimento dei dati per indicare che i seguenti dati vanno
spostati sulla riga successiva in un oggetto testo. Selezionare uno dei quattro codici di avanzamento riga
oppure digitare il codice avanzamento riga desiderato (massimo di 20 caratteri).

10. Replace FNC1 (Sostituire FNC1)
Sostituisce i codici GS con FNC1.

11. Number of Copies (Numero di copie)
Imposta il numero di copie (massimo 99 copie).

12. Auto Cut (Taglio Autom.)
Stabilisce se la stampante deve tagliare le etichette e il numero di etichette da stampare prima del taglio
(massimo 99 etichette).

13. Inverted 180 Degrees (Invertita a 180 gradi)
Se questa casella di controllo è selezionata, i dati saranno stampati dopo essere stati ruotati di 180 gradi.

14. Communication Settings (Impostazioni di comunicazione)
Imposta i parametri per la comunicazione seriale.

15. Default (Predefinito)
Riporta ai valori predefiniti tutti i valori di impostazione della finestra di dialogo Impostazioni P-touch
Template.

16. Cancel (Annulla)
Annulla le impostazioni e chiude la finestra di dialogo. Le impostazioni restano invariate.

17. Set (Imposta)
Applica le impostazioni alla stampante. Per salvare le impostazioni specificate in un file di comando per
utilizzi futuri, selezionare il comando Save in Command File (Salva nel file di comando) dall'elenco a
discesa.
Il file di comando salvato può essere usato con la modalità di archiviazione di massa per applicare le
impostazioni a una stampante.

  Informazioni correlate

• Modifica delle impostazioni stampante tramite lo Strumento di impostazione della stampante (Windows)

Argomenti correlati:
• Stampa tramite interfaccia USB (modalità di archiviazione di massa) 
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Impostazione del formato carta dello Strumento di impostazione della
stampante (Windows)

Tramite l'Impostazione formato carta nello Strumento di impostazione della stampante, è possibile aggiungere i
formati carta non disponibili nell'elenco Formato carta del driver stampante.
Prima di stampare con un formato carta diverso da quello disponibile, è necessario registrare il nuovo formato
carta inviandolo alla stampante.
La stampa con un formato carta non registrato nella stampante potrebbe produrre risultati di stampa errati.

Finestra di dialogo Impostazione formato carta

3

2

4

5

6

78

1

1. Impostazioni correnti
Visualizza le impostazioni correnti relative al formato carta selezionato.

2. Nuovo
Fare clic su questo pulsante per visualizzare la finestra di dialogo Nuovo e registrare un nuovo formato carta.

NOTA
Non registrare un formato carta già registrato, per evitare risultati di stampa non corretti. Per usare carta
dello stesso formato di quella registrata correntemente, selezionare il formato desiderato dall'elenco
Formato carta registrato correntemente nella finestra di dialogo Impostazione formato carta, quindi
modificare e sovrascrivere le impostazioni tramite la finestra di dialogo Modifica.

3. Modifica
Modifica le impostazioni relative al formato carta selezionato.
Per salvare il formato carta selezionato con le nuove impostazioni, fare clic su Sovrascrivi. Per aggiungere
un formato carta con le nuove impostazioni, modificare il nome nella casella Nome formato carta, quindi
fare clic su Aggiungi.

4. Elimina
Elimina il formato carta selezionato. Un formato carta eliminato non può essere ripristinato.

5. Importa
Legge il file di testo contenente le impostazioni del formato carta e lo utilizza per sostituire il contenuto
dell'elenco Formato carta registrato correntemente.
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NOTA
Quando l'elenco viene importato, tutto il contenuto dell'elenco Formato carta registrato correntemente
verrà sostituito con i formati carta importati.

6. Esporta
Esporta in un file i formati carta dell'elenco Formato carta registrato correntemente. I formati esportati
possono essere quindi distribuiti su altri computer.

7. Esci
Esce dalla finestra Impostazione formato carta e torna alla finestra principale dello Strumento di
impostazione della stampante.

8. Opzione
Fare clic su b, quindi selezionare un'operazione.
Fare clic su Registra il formato carta con la stampante per registrare le impostazioni relative al formato
carta selezionato nella stampante.
Fare clic su Salva nel file di comando per esportare le impostazioni della carta come file di comando.
(L'estensione del file è BIN.)

NOTA
Quando il formato carta viene registrato sulla stampante e si fa clic su Esci, viene visualizzata la finestra di
dialogo Impostazione formato carta con il formato carta aggiunto all'elenco Formato carta registrato
correntemente. Se il software è in esecuzione, uscire dal software, quindi riavviarlo affinché il nuovo formato
carta venga visualizzato nell'elenco.

• Se si utilizzano le seguenti funzioni, è possibile applicare rapidamente le relative impostazioni alla
stampante:
- Funzionalità di archiviazione di massa

• Questi comandi vanno usati solo per applicare le impostazioni a una stampante. Questi comandi non
possono essere importati nell'Impostazione formato carta.

>>  Finestra di dialogo Nuovo
>> Finestra di dialogo Regolazioni di stampa avanzate

Finestra di dialogo Nuovo

4

2

5

67

1

3

1. Nome formato carta
Digitare il nome del formato carta da aggiungere.
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2. Configurazione supporto automatica
Recupera e visualizza le informazioni relative alla carta impostata nella stampante. Per ulteriori informazioni
uu Informazioni correlate

Quando si usa questa opzione, portare la stampante in idle. Se si tenta di eseguire la configurazione
mentre è in corso la stampa di un lavoro, la stampante potrebbe non funzionare correttamente.

3. Tipi di carta
Consente di selezionare il tipo di carta.

4. Impostazioni dettagliate
Consente di specificare i dettagli del formato carta da aggiungere.

5. Regolazioni di stampa avanzate
Fare clic su questo pulsante per visualizzare la finestra di dialogo Regolazioni di stampa avanzate ed
effettuare regolazioni di stampa avanzate per ciascun formato carta.

6. Annulla
Annulla le impostazioni e chiude la finestra di dialogo. Le impostazioni resteranno invariate.

7. Aggiungi
Fare clic su questo pulsante per aggiungere il formato carta e applicare le impostazioni.

Finestra di dialogo Regolazioni di stampa avanzate

3

4

67

1

2

5

1. Regolazione punto di riferimento stampa
Consente di regolare la posizione del punto di riferimento (punto di origine per la stampa). Corregge gli errori
di allineamento della stampa derivanti dalle differenze nei modelli di stampante o dai margini fissi di alcuni
software.

2. Regola strappo
Regolare la posizione di taglio da utilizzare quando si taglia la carta tramite la barra di strappo.

3. Livello energia
Regolare la quantità di calore (energia) emessa dalla testina di stampa, ad esempio per carte speciali.

Nel risultato di stampa potrebbero essere presenti delle variazioni del contrasto dovute all'ambiente
operativo e al supporto di stampa usato. Modificare le impostazioni a seconda delle necessità.

4. Sensore multimediale (trasmissivo/spazio)
Regolare la precisione con la quale il sensore trasmissivo/spazio rileva gli spazi (spaziature) per le etichette
pretagliate e la quantità di luce emessa dal sensore.
Le impostazioni possono essere specificate quando Tipi di carta è impostato su Etichetta pretagliata.
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L'impostazione di Sensore multimediale (trasmissivo/spazio) nella finestra di dialogo Impostazioni
dispositivo può incidere sui risultati di rilevamento e calibrazione. Assicurarsi di specificare i valori
appropriati.
Impostazioni di esempio:

Impostazione EX1 Impostazione EX2

Impostazioni dispositivo +2 -2

Impostazione formato carta +2 +2

Effetto corrente 4 0

5. Sensore multimediale (riflettente/barra)
Consente di regolare la precisione con la quale il sensore riflettente/segno nero rileva i segni neri e la
quantità di luce emessa dal sensore.
Le impostazioni possono essere specificate quando Tipi di carta è impostato su Supporto con segni.

L'impostazione di Sensore multimediale (riflettente/barra) nella finestra di dialogo Impostazioni
dispositivo può incidere sui risultati di rilevamento e calibrazione. Assicurarsi di specificare i valori
appropriati.
Impostazioni di esempio:

Impostazione EX1 Impostazione EX2

Impostazioni dispositivo +2 -2

Impostazione formato carta +2 +2

Effetto corrente 4 0

6. Annulla
Annulla le impostazioni e chiude la finestra di dialogo. Le impostazioni resteranno invariate.

7. OK
Salva le impostazioni e torna alla precedente finestra di dialogo.

  Informazioni correlate

• Modifica delle impostazioni stampante tramite lo Strumento di impostazione della stampante (Windows)

• Distribuzione dei formati carta su altri computer (Windows)

Argomenti correlati:
• Configurazione supporto automatica 
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Distribuzione dei formati carta su altri computer (Windows)
I formati carta esportati dall'elenco Formato carta registrato correntemente nella finestra di dialogo
Impostazione formato carta possono essere distribuiti su altri computer. Se il driver della stampante è stato
installato sul computer di destinazione, è sufficiente distribuire i soli formati carta.
1. Nel computer del mittente, specificare le impostazioni del formato carta, quindi fare clic su Esporta.

Vengono creati i seguenti file:

TD-4410D bst441ed.ptd
bst441ed.txt
pdt3735.bin

TD-4420DN bst442ed.ptd
bst442ed.txt
pdt3835.bin

TD-4520DN bst452ed.ptd
bst452ed.txt
pdt4135.bin

2. Salvare il file TXT su qualsiasi posizione sul computer del destinatario.
3. Nel computer di destinazione, fare clic su Importa.

I formati carta vengono sostituiti con quelli importati.

  Informazioni correlate

• Impostazione del formato carta dello Strumento di impostazione della stampante (Windows) 
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Applicazione delle modifiche delle impostazioni a più stampanti
(Windows)

>> Impostazioni di comunicazione (TD-4420DN/TD-4520DN)
>> Impostazioni dispositivo

Impostazioni di comunicazione (TD-4420DN/TD-4520DN)

1. Dopo aver applicato le impostazioni alla prima stampante, scollegare la stampante dal computer e collegare
la seconda stampante al computer.

2. Selezionare la stampante appena collegata dall'elenco a discesa Stampante.
Se la casella di controllo Rileva automaticamente la stampante collegata e recupera le impostazioni
correnti nella finestra di dialogo Impostazioni opzioni è selezionata, la stampante collegata mediante cavo
USB viene selezionata automaticamente.

3. Fare clic su Applica.
Le stesse impostazioni che erano state applicate alla prima stampante vengono applicate alla seconda.

4. Ripetere questi passaggi per tutte le stampanti di cui si desidera modificare le impostazioni.

• Se l'indirizzo IP è impostato su STATIC, l'indirizzo IP della stampante viene modificato allo stesso
indirizzo della prima stampante. Modificare l'indirizzo IP, se necessario.

• Per salvare le impostazioni correnti in un file, fare clic su File > Esporta. È possibile applicare le stesse
impostazioni a un'altra stampante facendo clic su File > Importa e selezionando quindi il file delle
impostazioni esportate.

Impostazioni dispositivo

1. Dopo aver applicato le impostazioni alla prima stampante, scollegare la stampante dal computer e collegare
la seconda stampante al computer.

2. Selezionare la stampante appena collegata dall'elenco a discesa Stamp.
3. Fare clic su Applica. Le stesse impostazioni che erano state applicate alla prima stampante vengono

applicate alla seconda.
4. Ripetere questi passaggi per tutte le stampanti di cui si desidera modificare le impostazioni.

Per salvare le impostazioni correnti in un file, fare clic su File > Esporta. È possibile applicare le stesse
impostazioni a un'altra stampante facendo clic su File > Importa e selezionando quindi il file delle
impostazioni esportate.

  Informazioni correlate

• Impostazioni stampante 
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Modifica delle impostazioni stampante mediante la Gestione basata sul
Web

Modelli correlati: TD-4420DN/TD-4520DN

È possibile utilizzare un browser Web per modificare le impostazioni del server di stampa utilizzando il protocollo
HTTP (Hyper Text Transfer Protocol) oppure il protocollo HTTPS (Hyper Text Transfer Protocol over Secure
Socket Layer).

In Gestione pagina Web sono disponibili le seguenti operazioni:
• Visualizzare le informazioni sullo stato della stampante.
• Modificare le impostazioni di rete quali le informazioni TCP/IP.
• Visualizzare le informazioni sulla versione del software della stampante e del server di stampa.
• Modificare i dettagli della configurazione di rete e della stampante.

• Si consiglia di utilizzare Microsoft Internet Explorer 11/Edge per Windows. Assicurarsi che JavaScript e i
cookie siano sempre attivati, a prescindere dal browser in uso.

• La password di accesso predefinita per la gestione delle impostazioni della stampante è initpass. Si
consiglia di modificarla per proteggere la stampante da accessi non autorizzati.

Per utilizzare la Gestione pagina Web, la rete deve utilizzare il protocollo TCP/IP e la stampante e il computer
devono avere un indirizzo IP valido.
1. Avviare il browser Web.
2. Digitare "https://indirizzo IP della macchina" nella barra degli indirizzi del browser (dove "indirizzo IP della

macchina" è l'indirizzo IP della macchina).
Ad esempio:
https://192.168.1.2

Se si utilizza un DNS (Domain Name System) o si abilita un nome NetBIOS, è possibile immettere al posto
dell'indirizzo IP un altro nome, ad esempio "StampanteCondivisa".
• Ad esempio:

http://StampanteCondivisa
Se si abilita un nome NetBIOS, è inoltre possibile utilizzare il nome del nodo.
• Ad esempio:

https://brnxxxxxxxxxxxx

3. Se la macchina richiede una password, digitarla e fare clic su .

4. Modificare le impostazioni del server di stampa.

Ogni volta che si accede a Gestione basata sul Web digitare la password nel campo Accesso, quindi fare clic su
. Dopo avere configurato le impostazioni, fare clic su  per uscire.

  Informazioni correlate

• Impostazioni stampante

• Impostare o modificare una password di accesso per Gestione basata sul Web 
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Impostare o modificare una password di accesso per Gestione basata
sul Web

Modelli correlati: TD-4420DN/TD-4520DN

È consigliabile modificare la password di accesso predefinita allo scopo di impedire l'accesso non autorizzato a
Gestione basata sul Web.
1. Avviare il browser Web.
2. Digitare "https://indirizzo IP della macchina" nella barra degli indirizzi del browser (dove "indirizzo IP della

macchina" è l'indirizzo IP della macchina).
Ad esempio:
https://192.168.1.2

Se si utilizza un DNS (Domain Name System) o si abilita un nome NetBIOS, è possibile immettere al posto
dell'indirizzo IP un altro nome, ad esempio "StampanteCondivisa".
• Ad esempio:

http://StampanteCondivisa
Se si abilita un nome NetBIOS, è inoltre possibile utilizzare il nome del nodo.
• Ad esempio:

https://brnxxxxxxxxxxxx

3. Effettuare una delle seguenti operazioni:

• Se la password è stata impostata in precedenza, immetterla e fare clic su .

• Se la password non è stata impostata in precedenza, digitare initpass e fare clic su .

4. Fare clic sulla scheda Amministratore.
5. Digitare la password che si intende utilizzare nel campo Immetti nuova password (fino a 32 caratteri).
6. Digitare nuovamente la password nel campo Conferma nuova password.
7. Fare clic su Invia.

  Informazioni correlate

• Modifica delle impostazioni stampante mediante la Gestione basata sul Web 
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Conferma delle impostazioni della stampante
È possibile stampare il rapporto delle impostazioni stampante senza collegare la stampante a un computer o a
un dispositivo mobile.

1. Accendere la stampante.
2. Caricare un rotolo RD di 102 mm o più largo nella stampante.

3. Tenere premuto  per due secondi.

Inizia la stampa del rapporto.

  Informazioni correlate

• Impostazioni stampante 
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Manutenzione ordinaria

• Pulizia della stampante
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Pulizia della stampante
Consigliamo di pulire la stampante a cadenza regolare per garantire prestazioni sempre ottimali.

Prima di pulire la stampante, scollegarla sempre dall'alimentazione.

>> Pulizia delle parti esterne dell'unità
>> Pulizia della fessura di uscita delle etichette
>> Pulizia del rullo
>> Pulizia della testina di stampa

Pulizia delle parti esterne dell'unità

• Rimuovere la polvere ed eventuali macchie dall'unità principale servendosi di un panno morbido e asciutto.
Per rimuovere i segni ostinati, utilizzare un panno leggermente bagnato con acqua.

IMPORTANTE

Non usare diluenti, benzene, alcol o qualsiasi altro solvente organico. Questi prodotti potrebbero
danneggiare la custodia esterna della stampante.

Pulizia della fessura di uscita delle etichette

• Eventuali residui di adesivo accumulati sulla fessura di uscita delle etichette possono causare inceppamenti
delle etichette. Pulire la fessura di uscita delle etichette con un bastoncino di cotone asciutto.

IMPORTANTE

Non utilizzare l'alcol per pulire la fessura di uscita delle etichette.

NOTA
- Rimuovere sempre le etichette espulse dalla fessura di uscita delle etichette. Se la fessura dovesse

bloccarsi, potrebbe verificarsi un inceppamento delle etichette.
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Pulizia del rullo

• Pulire il rullo con un panno privo di lanugine imbevuto di alcol isopropilico o etanolo. Dopo aver pulito il rullo,
assicurarsi che non vi sia rimasta lanugine o altro tipo di materiale.

Utilizzare alcol isopropilico o etanolo in conformità alle linee guida di sicurezza del produttore, se
applicabili.

Pulizia della testina di stampa

• Pulire la testina di stampa con un panno privo di lanugine o un bastoncino di cotone imbevuto di alcol
isopropilico o etanolo.
- Consigliamo di pulire la testina di stampa con cadenza mensile.

Utilizzare alcol isopropilico o etanolo in conformità alle linee guida di sicurezza del produttore, se
applicabili.

  Informazioni correlate

• Manutenzione ordinaria 
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Soluzione dei problemi

• Se si hanno problemi con la macchina

• Indicazioni di errore e manutenzione

• Problemi di stampa

• Informazioni sulla versione

• Ripristino della stampante
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Se si hanno problemi con la macchina
In questo capitolo è spiegato come risolvere i problemi tipici che si possono verificare durante l'utilizzo della
stampante. Se si riscontrano problemi con la stampante, controllare dapprima di avere eseguito le seguenti
operazioni in modo corretto:
• Collegare la stampante a una presa elettrica. Per ulteriori informazioni uu Informazioni correlate
• Rimuovere tutto l'imballaggio di protezione dalla stampante.
• Installare e selezionare il driver della stampante corretto. Per ulteriori informazioni uu Informazioni correlate
• Collegamento della stampante a un computer o dispositivo mobile. Per ulteriori informazioni uu Informazioni

correlate
• Chiudere completamente il coperchio del vano del rotolo.
• Inserire il rotolo RD correttamente. Per ulteriori informazioni uu Informazioni correlate
Se i problemi persistono uu Informazioni correlate Se, dopo avere letto gli argomenti, non è ancora possibile
risolvere il problema, visitare il sito Web di supporto Brother all'indirizzo support.brother.com.

  Informazioni correlate

• Soluzione dei problemi

Argomenti correlati:
• Collegamento del cavo di alimentazione
• Installare i driver e il software della stampante su un computer
• Connettere la stampante a un computer
• Caricamento del rotolo RD 
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Indicazioni di errore e manutenzione
Gli indicatori si illuminano e lampeggiano per segnalare lo stato della stampante.

 o  o Indicatore illuminato nel colore mostrato.

 o  o Indicatore lampeggiante nel colore mostrato.

L'indicatore può essere spento, acceso o lampeggiante in qualsiasi colore.

L'indicatore è spento.

LED alimentazione LED del rotolo LED di stato Condizione Azione

L'alimentazione è
disattivata

-

Modalità di avanzamento
carta

-

Modalità di stampa -

Modalità di taglio -

Modalità di standby -

Modalità di archiviazione
di massa

-

Rilevamento del formato
carta

-

(Una volta per 3
secondi)

La stampa è in pausa -

(Una volta per 2
secondi)

Ricezione dati -

(Una volta per 1
secondo)

Eliminazione del lavoro
di stampa

-

Modalità di preparazione
della stampa

-

Modalità di download -

Modalità di
raffreddamento

-

Errore di apertura del
coperchio

Chiudere il coperchio del
vano del rotolo fino a
quando non si blocca al
proprio posto.

Errore di file BLF Premere un pulsante
qualsiasi per cancellare
l'errore.Errore di comunicazione

Errore di ricerca nel
database

Nessun errore di modello

Errore di memoria piena

Errore di memoria ESC/P
piena
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LED alimentazione LED del rotolo LED di stato Condizione Azione

Errore di file JPEG Premere un pulsante
qualsiasi per cancellare
l'errore.

Errore fine rotolo Premere  per
cancellare l'errore.
Inserire un rotolo che
corrisponde
all'impostazione della
carta e che abbia carta
residua a sufficienza.

Errore di alimentazione
carta

Premere  per
cancellare l'errore.
Inserire un rotolo che
corrisponde
all'impostazione della
carta.

(Una volta per 3
secondi)

Modalità riposo -

(Una volta per 1
secondo)

Passaggio alla modalità
di archiviazione di massa

-

La stampante si trova
nella modalità di sistema
spento

-

Modalità di
inizializzazione

-

(Due volte per 2
secondi)

Errore di archiviazione di
massa

Premere e tenere premuto
 per cancellare l'errore.

Errore taglierina

Errore non rilevato della
testina di stampa

La stampante è in
modalità di avvio

Contattare il Servizio
clienti Brother.

(Una volta per 2
secondi)

(Una volta per 2
secondi)

(Una volta per 2
secondi)

La modalità di
reimpostazione è attivata

-

(lampeggia
velocemente)

(lampeggia
velocemente)

(lampeggia
velocemente)

Errore di sistema Contattare il Servizio
clienti Brother.

Modalità di sovrascrittura
dei dati

-

Il coperchio del vano del
rotolo è aperto.

Chiudere il coperchio del
vano del rotolo fino a
quando non si blocca al
proprio posto.

  Informazioni correlate

• Soluzione dei problemi 
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Problemi di stampa

Problemi di stampa

Problema Soluzione

L'indicatore LED non si accende. • Il cavo dell'adattatore è collegato correttamente?
Verificare che il cavo sia collegato correttamente.

• Se l'indicatore LED ancora non si accende, contattare il servizio clienti
Brother.

La stampante non stampa, oppure
si verifica un errore di stampa.

• Il cavo si è allentato?
Verificare che il cavo sia collegato correttamente.

• Il rotolo è installato correttamente?
In caso negativo, rimuovere il rotolo e reinstallarlo.

• Il rotolo è esaurito?
Installare un nuovo rotolo.

• Il coperchio del vano del rotolo è aperto?
Verificare che il coperchio del vano del rotolo sia chiuso.

• Si è verificato un errore di stampa o trasmissione?
Spegnere e riaccendere la stampante. Se il problema persiste, contattare il
servizio clienti Brother.

• Se la stampante è collegata tramite un hub USB, provare a collegarla
direttamente al computer. In caso contrario, provare a collegarla a un'altra
porta USB.

Nel computer viene visualizzato
un messaggio di errore di
trasmissione dei dati.

• È stata selezionata la porta corretta?
Verificare che sia stata selezionata la porta corretta.

• La stampante e in modalità di raffreddamento?
Se il LED dell'alimentazione è verde e il LED di stato lampeggia in arancione,
attendere che il LED di stato smetta di lampeggiare, quindi provare
nuovamente a effettuare la stampa.

• Ci sono lavori di stampa incompleti?
Se si tenta di stampare mentre altri utenti stanno stampando grandi quantità
di dati, la stampante non riesce ad accettare il lavoro di stampa fino al termine
del lavoro di stampa in corso. In questi casi, inviare di nuovo il lavoro di
stampa una volta completati gli altri lavori di stampa.

Si desidera annullare il lavoro di
stampa corrente.

Mentre la stampa è in pausa, premere .

La qualità di stampa è bassa. Sulla testina di stampa o sul rullo premicarta è presente polvere o sporcizia che
impediscono la rotazione?
Pulire la testina di stampa o il rullo. Per ulteriori informazioni uu Informazioni
correlate

La stampante non alimenta la
carta.

• Nel rullo è presente sporcizia o lanugine, che ne impediscono la libera
rotazione?
Pulire il rullo. Per ulteriori informazioni uu Informazioni correlate

• Verificare che il percorso di espulsione della carta non sia bloccato.
• Rimuovere il rotolo e reinstallarlo. Per ulteriori informazioni uu Informazioni

correlate
• Verificare che il coperchio del vano del rotolo sia completamente chiuso.
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Problema Soluzione

La stampante fa avanzare la carta
in modo continuo.

• Aprire il coperchio del vano del rotolo.
• Premere qualsiasi pulsante per arrestare l'avanzamento.

Mentre la stampa è in pausa, premere  per annullare il lavoro di stampa.

Mentre la stampa è in pausa, per riprendere la stampa, premere qualsiasi
pulsante tranne .

La stampante non si ferma tra
un'etichetta e l'altra.

• Verificare di aver immesso correttamente le informazioni relative al supporto.
È possibile configurare le informazioni del supporto di stampa utilizzando
l'opzione Impostazione formato carta nello Strumento di impostazione della
stampante.

• Se il sensore è sporco, pulirlo con un bastoncino di cotone asciutto.
• Assicurarsi che non vi siano elementi che bloccano il sensore.

Quando non è possibile far
avanzare il rotolo fino all'inizio
dell'area di stampa viene
visualizzato un errore.

Se si verifica un errore di avanzamento, utilizzare Impostazione formato carta
dello Strumento di impostazione della stampante per assegnare alla stampante
le impostazioni del formato carta corrette.

La stampante è in modalità
raffreddamento.

La temperatura della testina di stampa termica è troppo elevata.
La stampante interrompe la stampa e la riprende solo dopo che la testina termica
si è raffreddata. Se si stampa un numero elevato di etichette, la testina di stampa
termica potrebbe surriscaldarsi.
Se la testina termica si surriscalda, potrebbe generare immagini al di fuori
dell'area di stampa. Per evitare o tardare il surriscaldamento, accertarsi che la
stampante sia soggetta ad adeguata ventilazione e non sia posizionata in uno
spazio ristretto.
Se la stampante deve raffreddarsi perché si è surriscaldata a causa del tipo di
rotolo in uso o del contenuto dell'etichetta, la stampa potrebbe durare più del
previsto.

NOTA
Questa condizione può presentarsi più frequentemente quando si utilizza
la stampante ad altitudini elevate (oltre i 3048 m), in quanto il
raffreddamento della stampante avviene in presenza di aria di minore
densità.

Si desidera reimpostare la
stampante/eliminare i dati trasferiti
dal computer.

uu Informazioni correlate

Non è possibile collegare la
testina di stampa.

Se la molla della testina di stampa fuoriesce, non è possibile collegare la testina
di stampa. Posizionare correttamente la molla della testina di stampa e riprovare.

Il supporto di stampa non viene
espulso correttamente in caso di
utilizzo della sfogliatrice etichette
opzionale.

Il sensore della sfogliatrice etichette è stato esposto alla luce solare diretta?
Se il sensore della sfogliatrice etichette è stato esposto alla luce solare diretta, è
possibile che il supporto di stampa caricato non sia stato rilevato correttamente.
Utilizzare la stampante in un luogo non esposto alla luce solare diretta.
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Problema Soluzione

Quando si stampa tramite il cavo
USB, la stampante effettua pause
continue, poi riprende a stampare.

• La stampante è impostata per la stampa sequenziale? In tal caso, impostare
la modalità di stampa con buffering.
- Windows 10/Windows Server 2016:

Fare clic su Start > Impostazioni > Dispositivi > Stampanti e scanner.
Fare clic sulla stampante che si desidera configurare, quindi fare clic su
Apri coda. Fare clic su Stampante > Preferenze stampa.
Fare clic sulla scheda Altro, quindi selezionare l'opzione Inizia stampa al
termine dello spooling dell'ultima pagina.

- Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012
R2:
Fare clic su Pannello di controllo sullo schermo Applicazioni. Fare clic
su Hardware e suoni > Dispositivi e stampanti. Fare clic con il pulsante
destro del mouse sulla stampante che si desidera configurare, quindi fare
clic sul menu Preferenze stampa.
Fare clic sulla scheda Altro, quindi selezionare l'opzione Inizia stampa al
termine dello spooling dell'ultima pagina.

- Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Dispositivi e stampanti. Fare clic
con il pulsante destro del mouse sulla stampante che si desidera
configurare, quindi fare clic sul menu Preferenze stampa.
Fare clic sulla scheda Altro, quindi selezionare l'opzione Inizia stampa al
termine dello spooling dell'ultima pagina.

• (TD-4420DN/TD-4520DN) Una soluzione alternativa consiste nello scollegare
il cavo LAN fino al termine della stampa USB.

Per Windows
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Problema Soluzione

I codici a barre stampati
utilizzando applicazioni diverse da
P-touch Editor non possono
essere letti.

Se i dati del codice a barre sono stati creati utilizzando l'orientamento
orizzontale, modificare l'impostazione Orientamento nella scheda Base del
driver stampante impostandola su Orizzontale, quindi riprovare.

Problemi con l'immagine stampata

Problema Soluzione

La carta stampata presenta delle
righe o dei caratteri di scarsa
qualità oppure la carta non viene
prelevata correttamente.

La testina di stampa o il rullo sono sporchi?
Anche se generalmente la testina di stampa resta pulita durante l'uso normale, è
possibile che della lanugine o della sporcizia provenienti dal rullo si inceppino
nella testina della stampante. In tal caso, pulire il rullo. Per ulteriori informazioni
uu Informazioni correlate

La lettura dei codici a barre
stampati risulta impossibile.

• Stampare le etichette in modo tale che i codici a barre siano allineati con la
testina di stampa, come illustrato qui di seguito:

1

2

3

1. Testina di stampa
2. Codici a barre
3. Orientamento di stampa

• Se le loro dimensioni vengono ridotte o ingrandite, i codici a barre potrebbero
non essere leggibili.

Problemi di rete (TD-4420DN/TD-4520DN)

Problema Soluzione

Si sta utilizzando un software di
sicurezza.

• Confermare le impostazioni nella finestra di dialogo dell'installazione.
• Consentire l'accesso quando compare il messaggio di avviso del software di

sicurezza durante l'installazione della stampante.

Si sta utilizzando il filtro per
indirizzi MAC.

È possibile verificare l'indirizzo MAC stampando il report delle impostazioni della
stampante. Per ulteriori informazioni uu Informazioni correlate

La stampante non si collega
correttamente alla rete.

• Assicurarsi che la stampante si trovi nella modalità preferita per la
connessione.
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Problema Soluzione

• Se ancora non si riesce a collegare la stampante, effettuare le seguenti
operazioni:
- Per LAN cablata

Verificare che il cavo LAN sia collegato correttamente.

Alla stampante non è stato
assegnato un indirizzo IP valido.

• Confermare l'indirizzo IP e la maschera di sottorete. Verificare che gli indirizzi
IP e le maschere di sottorete del computer e della stampante siano corretti e
situati nella stessa rete.
Per maggiori informazioni sulla verifica dell'indirizzo IP e della maschera di
sottorete, contattare l'amministratore di rete.

• Confermare l'indirizzo IP, la maschera di sottorete e altre impostazioni di rete
con lo Strumento di impostazione della stampante. Per ulteriori informazioni
uu Informazioni correlate

Il lavoro di stampa precedente
non è riuscito.

• Se un lavoro di stampa non completato è ancora presente nella coda di
stampa del computer, eliminarlo.
Ad esempio, se si usa Windows 10:
Fare clic su Start > Impostazioni > Dispositivi > Stampanti e scanner.
Fare clic sulla stampante che si desidera configurare, quindi fare clic su Apri
coda. Fare clic su Stampante > Annulla tutti i documenti.

Sono stati fatti tutti i controlli e i
tentativi di cui sopra, ma la
stampante non stampa.

Disinstallare e reinstallare il driver stampante e il software.

Non è stato selezionato di
concedere l'accesso quando è
stata visualizzata la finestra di
dialogo Avvisi di protezione
durante l'installazione standard,
durante l'installazione di BRAdmin
Light o durante la stampa.

Se alla visualizzazione della finestra di dialogo dell'avviso di sicurezza non è
stato selezionato di concedere l'accesso, la funzione firewall del software di
protezione potrebbe negare l'accesso. Qualche software di sicurezza potrebbe
bloccare l'accesso senza visualizzare una finestra di dialogo con l'avviso di
sicurezza. Per consentire l'accesso, vedere le istruzioni del software di
protezione o contattare il produttore.

Per le funzioni di rete Brother
vengono usati dei numeri di porta
non corretti.

Per le funzioni di rete Brother sono utilizzati i seguenti numeri di porta:
• BRAdmin Light: Numero porta 161 / Protocollo UDP

Per ulteriori informazioni su come aprire la porta, consultare le istruzioni
relative al software di sicurezza o contattare il produttore.

  Informazioni correlate

• Soluzione dei problemi

Argomenti correlati:
• Ripristino della stampante
• Pulizia della stampante
• Caricamento del rotolo RD
• Conferma delle impostazioni della stampante
• Impostazioni di comunicazione dello Strumento di impostazione della stampante (Windows) 

110



 Pagina Iniziale > Soluzione dei problemi > Informazioni sulla versione

Informazioni sulla versione

Problema Soluzione

Non si conosce il numero di
versione del firmware per la
stampante.

È possibile verificare il numero di versione del firmware stampando il report delle
impostazioni stampante. Per ulteriori informazioni uu Informazioni correlate

Si desidera verificare se si sta
usando la versione più recente del
software.

Usare P-touch Update Software per verificare se si dispone della versione più
recente. Per ulteriori informazioni su P-touch Update Software uu Informazioni
correlate

  Informazioni correlate

• Soluzione dei problemi

Argomenti correlati:
• Conferma delle impostazioni della stampante
• Aggiornamento del firmware 
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Ripristino della stampante
Il ripristino della memoria interna della stampante è indicato per eliminare tutti i file di etichetta salvati e qualora
la stampante non funzioni correttamente.
>> Ripristino di tutte le impostazioni ai valori predefiniti di fabbrica mediante i pulsanti della stampante
>> Ripristino dei dati mediante lo Strumento di impostazione della stampante

Ripristino di tutte le impostazioni ai valori predefiniti di fabbrica mediante i
pulsanti della stampante

1. Spegnere la stampante.

2. Premere e tenere premuto  e  per tre secondi circa.

Tutti gli indicatori LED lampeggiano di rosso.

3. Continuare a tenere premuto .

• (TD-4420DN/TD-4520DN) Premere  una volta per ripristinare le impostazioni di rete.

L'indicatore LED di alimentazione si illumina di rosso.

• (TD-4420DN/TD-4520DN) Premere  due volte per ripristinare i dati trasferiti e le impostazioni del
dispositivo.
L'indicatore LED del rotolo si illumina di rosso.

• Premere  tre volte per ripristinare tutte le impostazioni e le impostazioni dispositivo ai valori di
fabbrica.
L'indicatore LED di stato si illumina di rosso.

4. Rilasciare .

Tutti gli indicatori LED lampeggiano di rosso quattro volte, quindi si illuminano di rosso.

Ripristino dei dati mediante lo Strumento di impostazione della stampante

È possibile utilizzare lo Strumento di impostazione della stampante da un computer per eseguire le seguenti
operazioni per la stampante:
• Eliminare i modelli e i database.
• (TD-4420DN/TD-4520DN) Ripristino delle impostazioni di comunicazione
• Reimpostare le impostazioni della stampante ai valori di fabbrica.

  Informazioni correlate

• Soluzione dei problemi 
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Appendice

• Specifiche

• Kit di sviluppo del software

• Configurazione supporto automatica

• Opzioni

• Numeri Brother
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Specifiche
>> Stampa
>> Dimensioni
>> Interfaccia
>> Ambiente
>> Alimentazione
>> Specifiche del supporto di stampa
>> Sistemi operativi compatibili

Stampa

Tecnologia di stampa Termica diretta

Risoluzione di stampa • TD-4410D/TD-4420DN
203 dpi

• TD-4520DN
300 dpi

Velocità di stampa (in base al supporto utilizzato) • TD-4410D/TD-4420DN

Massimo 203,2 mm/s 1

• TD-4520DN

Massimo 152,4 mm/sec 1

Larghezza di stampa massima • TD-4410D/TD-4420DN
104,1 mm

• TD-4520DN
108,4 mm

Lunghezza di stampa massima 3.000 mm

1 nell'ambiente standard Brother

Dimensioni

Peso • TD-4410D
Circa 2,08 kg

• TD-4420DN/TD-4520DN
Circa 2,08 kg

Dimensioni Circa 180 mm (L) x 155 mm (A) x 224 mm (P)

Interfaccia

USB USB Ver. 2.0 (velocità massima) (Tipo B)

Seriale RS232C (DB9 maschio) 1

LAN cablata (TD-4420DN/TD-4520DN) 10/100BASE-TX

1 Utilizzare un cavo seriale di lunghezza inferiore a 3 m.

Ambiente

Temperatura di esercizio Tra 5°C e 40°C

Umidità di esercizio Tra il 20% e l'85% (senza condensa)
Temperatura massima a bulbo asciutto: 27 °C

Temperatura di conservazione Tra -20°C e 60°C
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Umidità di conservazione Tra il 10 e l'90% (senza condensa)

Alimentazione

Adattatore Adattatore CA (100-240 V, 50/60 Hz)

Specifiche del supporto di stampa

Il materiale del supporto di stampa può influenzare la qualità di stampa.
Per ottenere risultati di stampa ottimali, consigliamo di utilizzare carta termica Brother (rotoli RD).

Tipo di supporto di stampa Polsiere, continuo, prefustellato, piegato a ventaglio, perforato, cartellino

Larghezza supporto Da 19 mm a 118 mm

Lunghezza di stampa minima 6,4 mm
Continuo: 6,4 mm
Sfogliatrice: 17 mm
Taglierina: 20 mm
Strappo: 18 mm

Spessore Da 0,058 mm a 0,279 mm

Diametro esterno rotolo (massimo) 127 mm

Diametro del nucleo (minimo) 12,7 mm

Sensore del supporto Trasmissivo, A riflessi

Sistemi operativi compatibili

Per l'elenco completo e aggiornato del software, visitare la pagina support.brother.com.

  Informazioni correlate

• Appendice 
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Kit di sviluppo del software
È disponibile un kit di sviluppo software (SDK, Software Development Kit) nel Brother Developer Center
(brother.com/product/dev).

(TD-4420DN/TD-4520DN) Il b-PAC SDK e gli SDK per i dispositivi mobili (Android™, iPhone e iPad) possono
anche essere scaricati. (Gli SDK disponibili sono soggetti a modifica senza preavviso.)

(TD-4410D) Il b-PAC SDK e gli SDK per dispositivi mobili (solo Android™) possono anche essere scaricati. (Gli
SDK disponibili sono soggetti a modifica senza preavviso.)

  Informazioni correlate

• Appendice 
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Configurazione supporto automatica

• Panoramica della configurazione supporto automatica

• Utilizzo della funzione di configurazione supporto automatica

• Controllare la posizione del sensore
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supporto automatica

Panoramica della configurazione supporto automatica
La configurazione supporto automatica permette alla stampante di rilevare in modo automatico le caratteristiche
della carta caricata, per selezionare le impostazioni di formato carta corrette.

Modello Elementi di rilevazione automatica

TD-4410D • Tipo carta
• Lunghezza
• Spaziatura di etichette
• Larghezza dei segni
• Sensibilità rilevamento distanza/tratto nero

TD-4420DN/TD-4520DN • Tipo carta
• Larghezza
• Lunghezza
• Spaziatura di etichette
• Larghezza dei segni
• Sensibilità rilevamento distanza/tratto nero

Flusso di lavoro della configurazione supporto automatica
Dopo aver avviato la configurazione supporto automatica, la stampante alimenterà la carta per rilevarne le
caratteristiche. Per impostazione predefinita, la stampante utilizza le impostazioni di avanzamento continuo, a
meno che:
• Il sensore trasmissivo/distanza rileva un'etichetta pretagliata.

• Il sensore riflettente/segno nero rileva il supporto indicato. 1

• In caso di esaurimento della carta in fase di configurazione supporto automatica, la stampante non
rileva correttamente il tipo di supporto e viene visualizzato un errore.

• Se la larghezza della carta non viene allineata correttamente, la calibrazione non avverrà
correttamente.

• A seconda della forma e del materiale della carta, potrebbe non essere possibile rilevare il supporto.
• (TD-4410D)

La larghezza della carta impostata è quella di ultima applicazione.
• (TD-4420DN/TD-4520DN)

La larghezza della carta viene calcolata sottraendo dalla larghezza rilevata 2,0 mm da sinistra e da
destra.

  Informazioni correlate

• Configurazione supporto automatica 

1 Potrebbe essere necessario alimentare di nuovo la carta, a seconda dei risultati.
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Utilizzo della funzione di configurazione supporto automatica
>> Calibrazione delle informazioni supporto mediante i pulsanti della stampante
>> Calibrazione delle informazioni supporto mediante lo strumento di impostazione della stampante

Calibrazione delle informazioni supporto mediante i pulsanti della stampante

• Premere e tenere premuto  per circa cinque secondi.

Al completamento della calibrazione, sulla stampante vengono impostate le informazioni sulla carta rilevata.

Calibrazione delle informazioni supporto mediante lo strumento di impostazione
della stampante

1. Collegare la stampante da configurare al computer.
2. Avviare lo Strumento di impostazione della stampante.

• Windows 10/Windows Server 2016:
Fare clic su Start > Brother > Printer Setting Tool.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic sull'icona Printer Setting Tool sulla schermata Applicazioni.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Tutti i programmi > Brother > Label & Mobile Printer > Printer
Setting Tool.

3. Fare clic su Impostazione formato carta.
4. Fare clic su Modifica o Nuovo.
5. (TD-4410D) Fare clic su Configurazione supporto automatica.

Al completamento della calibrazione, sulla stampante vengono impostate le informazioni sulla carta rilevata.
6. (TD-4420DN/TD-4520DN) Fare clic sull'elenco a discesa Configurazione supporto automatica, quindi

selezionare l'opzione Configurazione supporto automatica o l'opzione Acquisisci solo larghezza (no
avanzamento).
Vengono visualizzati i risultati del rilevamento.

7. Fare clic su Importa per applicare i risultati alle impostazioni di formato carta.

  Informazioni correlate

• Configurazione supporto automatica 
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Opzioni

• Pulizia di altri componenti della stampante

• Modifica delle impostazioni della sfogliatrice

• Modifica delle opzioni di taglio
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Pulizia di altri componenti della stampante
Consigliamo di pulire la stampante a cadenza regolare per garantire prestazioni sempre ottimali.

Prima di pulire la stampante, scollegarla sempre dall'alimentazione.

>> Rullo
>> Testina di stampa
>> Taglierina
>> Sfogliatrice di etichette

Rullo

TD-4410D/TD-4420DN PA-PR2-001

TD-4520DN PA-PR3-001

• Pulire il rullo con un panno privo di lanugine imbevuto di alcol isopropilico o etanolo. Dopo aver pulito il rullo,
assicurarsi che non vi sia rimasta lanugine o altro tipo di materiale.

Utilizzare alcol isopropilico o etanolo in conformità alle linee guida di sicurezza del produttore, se
applicabili.

Testina di stampa

TD-4410D/TD-4420DN PA-HU2-001

TD-4520DN PA-HU3-001

• Pulire la testina di stampa con un panno privo di lanugine o un bastoncino di cotone imbevuto di alcol
isopropilico o etanolo.
- Consigliamo di pulire la testina di stampa con cadenza mensile.

Utilizzare alcol isopropilico o etanolo in conformità alle linee guida di sicurezza del produttore, se
applicabili.
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Taglierina

TD-4410D/TD-4420DN/TD-4520DN PA-CU-001

NOTA
• Rimuovere sempre le etichette espulse dalla fessura di uscita delle etichette. Se la fessura dovesse

bloccarsi, potrebbe verificarsi un inceppamento delle etichette.
• L'accuratezza del taglio non può essere garantita per le etichette con perforazioni o sgualciture.

• Eventuali residui di adesivo accumulati sulla fessura di uscita delle etichette possono causare inceppamenti
delle etichette. Pulire la fessura di uscita delle etichette con un bastoncino di cotone asciutto.

IMPORTANTE

Non utilizzare l'alcol per pulire la fessura di uscita delle etichette.

Sfogliatrice di etichette

TD-4410D/TD-4420DN/TD-4520DN PA-LP-002

1. Pulire il rullo con un panno privo di lanugine imbevuto di alcol isopropilico o etanolo. Dopo aver pulito il rullo,
assicurarsi che non vi sia rimasta lanugine o altro tipo di materiale.

Utilizzare alcol isopropilico o etanolo in conformità alle linee guida di sicurezza del produttore, se
applicabili.

2. Eventuali residui di adesivo accumulati sulla sfogliatrice possono causare inceppamenti delle etichette. Pulire
la sfogliatrice con un bastoncino di cotone asciutto.

IMPORTANTE

Non utilizzare l'alcol per pulire la sfogliatrice.
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  Informazioni correlate

• Opzioni 
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Modifica delle impostazioni della sfogliatrice
Dopo avere collegato la sfogliatrice, impostare l'opzione della sfogliatrice nel driver stampante.
1. Effettuare una delle seguenti operazioni:

• Windows 10/Windows Server 2016:
Fare clic su Start > Impostazioni > Dispositivi > Stampanti e scanner. Fare clic sulla stampante che si
desidera configurare, quindi fare clic su Apri coda. Fare clic su Stampante > Preferenze stampa.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic su Pannello di controllo sullo schermo Applicazioni. Fare clic su Hardware e suoni >
Dispositivi e stampanti. Fare clic con il pulsante destro del mouse sulla stampante che si desidera
configurare, quindi fare clic sul menu Preferenze stampa.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Dispositivi e stampanti. Fare clic con il pulsante destro del mouse
sulla stampante che si desidera configurare, quindi fare clic sul menu Preferenze stampa.

2. Selezionare la casella di controllo Usa funzione sfogliatrice.
3. Fare clic su OK.

  Informazioni correlate

• Opzioni 
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Modifica delle opzioni di taglio
Le opzioni di taglio consentono di specificare come far avanzare e tagliare le etichette. Se non si utilizza P-touch
Editor, è possibile modificare le opzioni di raglio nelle proprietà del driver stampante.

1. Effettuare una delle seguenti operazioni:
• Windows 10/Windows Server 2016:

Fare clic su Start > Impostazioni > Dispositivi > Stampanti e scanner. Fare clic sulla stampante che si
desidera configurare, quindi fare clic su Apri coda. Fare clic su Stampante > Preferenze stampa.

• Windows 8/Windows 8.1/Windows Server 2012/Windows Server 2012 R2:
Fare clic su Pannello di controllo sullo schermo Applicazioni. Fare clic su Hardware e suoni >
Dispositivi e stampanti. Fare clic con il pulsante destro del mouse sulla stampante che si desidera
configurare, quindi fare clic sul menu Preferenze stampa.

• Windows 7/Windows Server 2008/Windows Server 2008 R2:
Fare clic su Fare clic per iniziare. > Dispositivi e stampanti. Fare clic con il pulsante destro del mouse
sulla stampante che si desidera configurare, quindi fare clic sul menu Preferenze stampa.

2. Selezionare la casella di controllo Taglia ogni, quindi selezionare dove tagliare quando si stampano più
etichette.

3. Selezionare la casella di controllo Taglia alla fine.
4. Fare clic su OK.

Opzioni di taglio delle etichette

Taglio automatico
(taglio dopo ogni
etichetta)

Taglia alla fine Immagine

Off On

ABCABC

Off Off

ABCABC

On On o Off

ABC

ABC

  Informazioni correlate

• Opzioni 
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Numeri Brother

IMPORTANTE

Per richiedere supporto tecnico, è necessario contattare il Servizio clienti Brother.

>> Servizio clienti
>> FAQ (domande frequenti)

Servizio clienti

Visitare il sito www.brother.com per ottenere informazioni su come contattare il proprio ufficio Brother di zona.

Sedi dei centri assistenza
Per conoscere i centri assistenza in Europa, contattare l'ufficio Brother di zona. Per informazioni su come
contattarci, visitare www.brother.com.

Indirizzi Internet
Sito Web internazionale Brother: www.brother.com
Per domande frequenti (FAQ), supporto prodotto e domande di carattere tecnico, aggiornamenti del driver e utility:
support.brother.com

FAQ (domande frequenti)

Per ulteriori informazioni sulla macchina Brother, visitare il sito Web dell'assistenza Brother support.brother.com.
Per ulteriore assistenza e suggerimenti, accedere alla pagina FAQ e Risoluzione dei problemi del modello; per
i driver e software della stampante più recenti, accedere alla pagina Download del modello.

  Informazioni correlate

• Appendice 
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Visitare il sito Brother sul World Wide Web all'indirizzo
www.brother.com
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